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Wykorzystaj wszystkie mo¿liwo�ci Excela, aby tworzyæ funkcjonalne i efektowne arkusze 

� Jak analizowaæ dane i zarz¹dzaæ nimi? 
� Jak optymalnie wykorzystywaæ tabele przestawne? 
� Jak tworzyæ spersonalizowane wykresy? 

Wiêkszo�æ u¿ytkowników Excela zna tylko drobn¹ czê�æ dostêpnych w nim mo¿liwo�ci. 
Istnieje jednak wiele metod pozwalaj¹cych znacz¹co poszerzyæ wydajno�æ tego 
programu i tworzyæ efektowne arkusze kalkulacyjne bez potrzeby czasoch³onnego 
zdobywania wiedzy. Nowa wersja Excela umo¿liwia chocia¿by ³atwiejsze korzystanie
z mechanizmu tabel przestawnych, formatowania warunkowego i nazw zakresów, 
podgl¹du �na ¿ywo�, galerii predefiniowanych stylów oraz grafik SmartArt. Wszystko to 
sprawia, ¿e ka¿dy mo¿e dzi� w swoich arkuszach u¿ywaæ bardziej skomplikowanych 
elementów wizualnych i graficznych.

Obecnie, kiedy wszystko dzieje siê coraz szybciej, czas staje siê jedn¹
z najistotniejszych i po¿¹danych warto�ci. Ksi¹¿ka �100 sposobów na Excel 2007 PL. 
Tworzenie funkcjonalnych arkuszy� pozwala Ci w³a�nie zyskaæ na czasie � oferuje 
ponad sto gotowych metod tworzenia funkcjonalnych i efektownych arkuszy, szybkich
i niezawodnych rozwi¹zañ skomplikowanych problemów. Warto tak¿e wykorzystaæ
te metody do przeanalizowania oraz zastosowania niektórych mo¿liwo�ci jêzyka Visual 
Basic for Applications (VBA) � dziêki temu bêdziesz móg³ zaadaptowaæ wszystkie 
zawarte tu propozycje do w³asnych potrzeb.

� Skoroszyty i arkusze 
� Wbudowane mechanizmy do analizy danych i zarz¹dzania nimi 
� Metody tworzenia nazw i zakresów komórek 
� Tabele przestawne 
� Formu³y i funkcje 
� Wykresy i makra 
� Wspó³praca Excela z innymi aplikacjami pakietu Office 

Wszystko, co chcia³by� widzieæ o Excelu, aby natychmiast z niego skorzystaæ.

Poznaj ponad setkê sposobów skutecznego radzenia sobie z Excelem! 
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R O Z D Z I A Ł  D R U G I

Sposoby na wbudowane
mechanizmy Excela

Sposoby 17. – 43.

Excel posiada co prawda dosyć szeroki zbiór standardowych mechanizmów zarządzania
i analizy danych, lecz ograniczenia tych narzędzi często wprawiają w irytację. Sposoby
przedstawione w tym rozdziale mają na celu obejście tych ograniczeń i w efekcie uczy-
nienie z Excela narzędzia o znacznie większych możliwościach.

S P O S Ó B

17.
Wszystkie

Sprawdzanie poprawności danych
na podstawie listy z innego arkusza
Sprawdzanie poprawności danych to narzędzie, w którym można zdefiniować reguły poprawności danych.
Niestety Excel „upiera się”, że listy używane w trakcie sprawdzania poprawności muszą znajdować się
w tym samym arkuszu, co weryfikowane dane. Na szczęście istnieją sposoby, bo ominąć ten wymóg.

W tym sposobie przedstawimy dwie metody, których można użyć do sprawdzenia po-
prawności danych na podstawie listy znajdującej się w innym arkuszu. W pierwszej meto-
dzie wykorzystywane są zakresy nazwane (opisane bardziej szczegółowo w rozdziale 3.),
druga natomiast polega na wywołaniu odpowiedniej funkcji.

Metoda 1. Zakresy nazwane
Chyba najłatwiejszą i najprostszą metodą obejścia ograniczeń istniejących w mechanizmie
sprawdzania poprawności danych jest zdefiniowanie komórek, w których znajduje się
lista, jako zakresu nazwanego. Aby utworzyć zakres nazwany, należy zaznaczyć komórki
zawierające listę i w polu Nazwa znajdującym się na lewym krańcu paska formuł wpisać
ich nazwę. W tym przykładzie przyjmiemy, że zakres ten nosi nazwę MójZakres.

Należy zaznaczyć komórkę, w której będzie miała się znajdować lista rozwijana, i z karty
Dane wybrać polecenie Narzędzia danych→Poprawność danych (w poprzednich wersjach Dane
→Sprawdzanie poprawności…). W polu Dozwolone: należy wskazać pozycję Lista, a w polu
Źródło: wpisać =MójZakres, po czym kliknąć przycisk OK.

Dzięki użyciu zakresu nazwanego danej listy można użyć jako listy poprawności, mimo
że znajduje się ona w innym arkuszu.
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Metoda 2. Funkcja ADR.POŚR
Funkcja ADR.POŚR pozwala na odwoływanie się do komórek zawierających tekst repre-
zentujący adres komórki. Komórki tej można zatem użyć jako odwołania do komórki
lokalnej, pomimo że pobiera ona dane z innego arkusza. Dzięki temu mechanizmowi
można więc odwoływać się do arkusza, w którym zdefiniowano listę.

Załóżmy, że listę zdefiniowano w arkuszu Arkusz1, w zakresie komórek $A$1:$A$8.
W innym arkuszu należy kliknąć komórkę, w której ma się pojawić lista sprawdzania po-
prawności danych (lista wyboru). Następnie na karcie Dane trzeba wybrać polecenie Na-
rzędzia danych→Poprawność danych (we wcześniejszych wersjach Dane→Sprawdzanie po-
prawności…) i w polu Dozwolone: wskazać pozycję Lista, a w polu Źródło: wpisać:

=ADR.POŚR("Arkusz1!$A$1:$A$8")

Należy jeszcze upewnić się, że zaznaczone jest pole wyboru Rozwinięcia w komórce, po czym
kliknąć przycisk OK. Na rozwijanej liście sprawdzania poprawności powinna pojawić się
lista zdefiniowana w arkuszu Arkusz1.

Jeżeli nazwa arkusza, w którym zdefiniowano listę, zawiera znaki spacji, trzeba będzie
użyć funkcji ADR.POŚR w następujący sposób:

=ADR.POŚR("'Arkusz 1'!$A$1:$A$8")

Różnica polega na tym, że w drugim przypadku należy wpisać znak apostrofu zaraz za
cudzysłowem otwierającym oraz kolejny apostrof przed znakiem wykrzyknika.

Dobrą praktyką jest używanie znaku apostrofu bez względu na to, czy nazwa
arkusza zawiera znaki spacji, czy nie. Obecność apostrofów nie zmieni sposobu
odwoływania się do arkusza, którego nazwa nie zawiera spacji, natomiast
znacznie ułatwi wprowadzanie ewentualnych zmian w przyszłości.

Wady i zalety obydwu metod
Zakresy nazwane i funkcja ADR.POŚR mają określone wady i zalety.

Zaletą zakresów nazwanych jest to, że jakakolwiek zmiana w nazwie arkusza nie będzie
miała żadnego wpływu na listę sprawdzania poprawności. Od razu widać więc wadę
funkcji ADR.POŚR: zmiana nazwy arkusza nie zostanie w tej funkcji odzwierciedlona
automatycznie, trzeba więc będzie ręcznie zmienić jej definicję, tak by była ona zgodna
z nową nazwą arkusza.

Zaletą funkcji ADR.POŚR jest to, że określony przez użytkownika zakres zawsze będzie taki
sam, co oznacza, że jeżeli wykorzystuje się taki nazwany zakres i usunie z niego wiersze
lub kolumny, to nazwany zakres zostanie samoczynnie odpowiednio dopasowany.
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S P O S Ó B

18.
Wszystkie

Sterowanie formatowaniem warunkowym
przy użyciu pól wyboru
Formatowanie warunkowe to jeden z najważniejszych mechanizmów Excela, lecz konieczność każdorazowego
jego włączania i wyłączania z poziomu wstążki stanowi pewną niedogodność. Dodanie w arkuszu pól wyboru,
które będą włączać i wyłączać formatowanie warunkowe, sprawi, że znacznie łatwiej będzie czytać dane
w dowolny sposób i w dowolnym momencie.

Formatowanie warunkowe — narzędzie dostępne począwszy od Excela w wersji 97
— służy do definiowania formatów dla komórek, których wartości spełniają określone
kryteria definiowane za pomocą osobnych wartości lub innych formuł. Warunki forma-
towania są najczęściej definiowane na podstawie wartości komórek, lecz użycie w ich
definicjach formuł zapewnia na tyle dużą elastyczność, że formatowanie warunkowe będzie
można zastosować w całej siatce arkusza.

Ustawianie wartości pól wyboru dla formatowania warunkowego
Pola wyboru dostępne w grupie Formanty formularza, które można znaleźć na karcie Dewelo-
per po wybraniu polecenia Formanty→Wstaw (we wcześniejszych wersjach znajdują się
one na pasku narzędzi Formularze), zwracają w komórce, z którą są powiązane, wartości
PRAWDA lub FAŁSZ (zaznaczone lub nie). Wykorzystując pole wyboru z grupy Formanty
formularza w połączeniu z formatowaniem warunkowym z ustawioną opcją Użyj formuły
do określenia komórek, które należy sformatować (we wcześniejszych wersjach jest to opcja
Formuła jest), widoczną na rysunku 2.1, można włączać i wyłączać formatowanie warun-
kowe w zależności od stanu pola wyboru.

Rysunek 2.1. Okno dialogowe Formatowanie warunkowe z opcją Formuły

Jeśli formatowanie warunkowe zostanie zdefiniowane przy użyciu formuły
(na przykład z opcją Użyj formuły do określenia komórek, które należy sformatować),
komórki zostaną sformatowane tylko wówczas, gdy wynikiem formuły będzie
PRAWDA. Każda formuła używana w tym sposobie musi zatem zwracać
wartości PRAWDA lub FAŁSZ.



SPOSÓB
18. Sterowanie formatowaniem warunkowym przy użyciu pól wyboru

66 | Sposoby na wbudowane mechanizmy Excela

Aby pokazać, co dokładnie mamy na myśli, posłużymy się prostym przykładem, w którym
przy użyciu formatowania warunkowego i pola wyboru zostaną ukryte dane. W przy-
kładzie tym użyjemy komórek z zakresu $A$1:$A$10 wypełnionych kolejnymi licz-
bami od 1 do 10. Aby z grupy Formanty formularza wstawić pole wyboru, należy przejść
na kartę Deweloper i wybrać polecenie Wstaw znajdujące się w grupie poleceń Formanty
(we wcześniejszych wersjach należy wyświetlić pasek narzędzi Formularze, wybierając
polecenie Widok→Paski narzędzi→Formularze), kliknąć pole wyboru, a następnie kliknąć
w pobliżu komórki C1, by umieścić je w tym miejscu. Następnie trzeba kliknąć prawym
przyciskiem myszy na polu wyboru i wybrać polecenie Formatuj formant…→Formant,
w polu Łącze komórki wpisać C1, tak jak na rysunku 2.2, i kliknąć przycisk OK.

Rysunek 2.2. Okno dialogowe Formatowanie formantu

Gdy pole wyboru umieszczone na komórce C1 zostanie kliknięte myszą, w komórce tej
pojawi się wartość PRAWDA lub FAŁSZ. Wartości te nie muszą być widoczne, można zatem
zaznaczyć komórkę C1 i zmienić kolor jej czcionki na biały.

W kolejnym kroku należy zaznaczyć komórki $A$1:$A$10, rozpoczynając zaznaczanie
od komórki A1, po czym przejść na kartę Narzędzia główne i z grupy opcji Style wybrać
polecenie Formatowanie warunkowe→Nowa reguła…. Następnie należy zaznaczyć opcję
Użyj formuły do określenia komórek, które należy sformatować (w wersjach wcześniejszych
należy kliknąć polecenie Format→Formatowanie warunkowe…, wskazać opcję Formuła jest;
początkowo wybrana będzie opcja Wartość komórki jest). W polu Formatuj wartości, dla których
następująca formuła jest prawdziwa: (w starszych wersjach w polu formuły z prawej strony)
trzeba wpisać =$C$1. Następnie w oknie dialogowym Nowa reguła formatowania trzeba
kliknąć przycisk Formatuj… (w starszych wersjach w oknie dialogowym Formatowanie
warunkowe trzeba wybrać zakładkę Czcionka) i zmienić kolor czcionki na biały. Na koniec
należy kliknąć przycisk OK i ponownie OK.
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Zaznaczenie pola wyboru spowoduje, że kolor czcionki w komórkach z zakresu $A$1:
$A$10 automatycznie zmieni się na biały. Usunięcie zaznaczenia pola wyboru sprawi, że
komórki powrócą do normalnego stanu.

Włączanie i wyłączanie wyróżniania liczb
Możliwość automatycznego wyróżniania liczb spełniających określone kryteria zdecy-
dowanie ułatwia wyszukiwanie w arkuszu potrzebnych danych.

Możliwość wykorzystania formatowania warunkowego do formatowania
liczb z pewnego zakresu jest nową opcją dostępną w Excelu 2007. Jednakże
możliwość zaznaczania i wyłączania pola wyboru opisana w tym sposobie
taką nie jest.

Aby skorzystać z tego udogodnienia, należy najpierw zaznaczyć komórkę E1 (lub dowolną
inną komórkę) i nadać jej nazwę ŁączePolaWyboru, wpisując ją w polu Nazwa z lewej
strony paska formuł (rysunek 2.3).

Rysunek 2.3. Komórce E1 nadano nazwę ŁączePolaWyboru

W komórce F1 należy umieścić pole wyboru z grupy narzędzi Formanty formularza (w po-
przednich wersjach z paska narzędzi Formularze). Jako Łącze komórki pola wyboru należy
wskazać komórkę ŁączePolaWyboru — w tym celu należy kliknąć pole wyboru prawym
przyciskiem myszy, wybrać Formatuj formant…→Formant, w polu Łącze komórki: wpisać
ŁączePolaWyboru i kliknąć OK.

Następnie należy ponownie kliknąć prawym przyciskiem myszy pole wyboru, wybrać
pozycję Edytuj tekst i wpisać słowa Pokaż mnie. W kolumnie A w innym arkuszu trzeba
wpisać liczby z zakresu od 25 do 2500, z których każda będzie wyższa od poprzedniej
o 25. Zakresowi temu należy nadać nazwę Liczby, a sam arkusz ukryć za pomocą polecenia
Widok→Ukryj (wcześniej Format→Arkusz→Ukryj).

Aby szybko wpisać te liczby, należy wpisać w komórce A1 liczbę 25.
Następnie należy kliknąć prawym przyciskiem myszy (kliknąć przycisk
Control na komputerach Mac) punkt wypełnienia (który pojawia się w formie
małego, czarnego kwadracika w prawym dolnym rogu zaznaczenia) i nadal
trzymając naciśnięty prawy przycisk myszy, przeciągnąć kursor o około
100 wierszy. Później trzeba zwolnić przycisk myszy, z menu kontekstowego
wybrać polecenie Seria danych…, w polu Wartość kroku wpisać 25, a w polu
Wartość końcowa wpisać 2500. Na koniec trzeba kliknąć przycisk OK.
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W kolejnym kroku na arkuszu PolaWyboru należy zaznaczyć komórkę B1 i nadać jej nazwę
PierwszaLiczba, po czym zaznaczyć komórkę D1 i nazwać ją DrugaLiczba. W komórce C1
natomiast trzeba wpisać wartość ORAZ. Następnie należy zaznaczyć komórkę B1 (Pierw-
szaLiczba) i trzymając wciśnięty klawisz Ctrl, zaznaczyć komórkę D1 (DrugaLiczba), po
czym wybrać polecenie Dane→Narzędzia danych→Poprawność danych (w wersjach wcze-
śniejszych jest to polecenie Dane→Sprawdzanie poprawności…→Ustawienia) i w polu Do-
zwolone: wybrać pozycję Lista, a w polu Źródło: wpisać =Liczby. Po upewnieniu się, że
pole wyboru Rozwinięcia w komórce jest zaznaczone, należy kliknąć przycisk OK. Dzięki tej
operacji w obu komórkach pojawią się listy rozwijane zawierające liczby od 25 do 2500.

W komórce A1 należy wpisać nagłówek Wartość, a w znajdującym się zaraz pod nią za-
kresie A2:A20 wpisać dowolne liczby należące do przedziału od 25 do 2500. Następnie
należy zaznaczyć zakres A2:A20 (upewniając się, że zaznaczenie rozpoczyna się od
komórki A2, która powinna być również komórką aktywną zaznaczenia) i wybrać polecenie
Narzędzia główne→Style→Formatowanie warunkowe→Nowa reguła… (w starszych wersjach
należy wybrać polecenie Format→Formatowanie warunkowe…).

W wyświetlonym oknie dialogowym przedstawionym na rysunku 2.4 trzeba wskazać
opcję Użyj formuły do określenia komórek, które należy sformatować (w wersjach wcześniej-
szych jest to opcja Formuła jest; na początku opcją aktywną będzie Wartość komórki jest).

Rysunek 2.4. Nowe okno dialogowe Formatowanie warunkowe

Następnie w polu Formatuj wartości, dla których następująca formuła jest prawdziwa (w wer-
sjach wcześniejszych jest to pole formuły) trzeba wpisać następującą formułę:

=ORAZ($A2>=PierwszaLiczba;$A2<=DrugaLiczba;ŁączePolaWyboru)

W oknie dialogowym Formatowanie komórek wyświetlonym po kliknięciu przycisku For-
matuj… należy zdefiniować pożądany format lub ich kombinację. Następnie trzeba kliknąć
przycisk OK, po czym kliknąć OK jeszcze raz w celu zamknięcia okien dialogowych. Kolor
czcionki w komórce ŁączePolaWyboru (E1) należy zmienić na biały, by wartości PRAWDA
i FAŁSZ nie były widoczne. W komórce PierwszaLiczba (B1) należy wybrać dowolną
liczbę, a w komórce DrugaLiczba (D1) — dowolną liczbę większą od pierwszej.
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Po zaznaczeniu pola wyboru zdefiniowane wcześniej formatowanie warunkowe zostanie
automatycznie zastosowane względem liczb, które będą należeć do wskazanego przedziału.
Usunięcie zaznaczenia pola wyboru spowoduje przywrócenie formatowania domyślnego.

Jak widać, odpowiednio wykorzystując pole wyboru i formatowanie warunkowe, można
wykonać operacje, które zdaniem większości użytkowników są możliwe do przeprowa-
dzenia jedynie przy użyciu kodu VBA.

S P O S Ó B

19.
Wszystkie

Odnajdywanie formuł
przy użyciu formatowania warunkowego
O tym, czy dana komórka zawiera wartość statyczną, czy też wartość ta jest wynikiem formuły, można
przekonać się, jedynie klikając w tej komórce i sprawdzając jej zawartość na pasku formuł lub klikając
klawisze Ctrl+~ (znak tyldy). Niniejszy sposób wypełnia tę lukę dzięki odpowiedniej funkcji.

Kod VBA zawarty w tej funkcji (zwanej również funkcją zdefiniowaną przez użytkownika)
pozwala na odszukanie komórek zawierających formuły bez konieczności klikania po
kolei 10 000 komórek i sprawdzania zawartości każdej z nich.

Można byłoby wybrać polecenie Formatowanie warunkowe→Nowa reguła…
(w wersjach wcześniejszych jest to polecenie Format→Formatowanie warunkowe
→Formuła jest…) oraz wykorzystać formułę =KOMÓRKA("Typ";A1) w sekcji
Użyj formuły do określenia komórek, które należy sformatować, ale należy mieć
zawsze świadomość, że jest to funkcja zmienna. Oznacza to, że jeżeli użytkownik
wykona jakąkolwiek zmianę w danym lub innym skoroszycie, gdy skoroszyt
zawierający formatowanie warunkowe jest nadal otwarty, zmusi to wszystkie
komórki używające funkcji KOMÓRKA do ponownego przeliczenia. Owe globalne
rekalkulacje mogą znacznie wpłynąć na wydajność rozbudowanych skoroszytów.
Niniejszy sposób reprezentuje lepsze rozwiązanie.

Aby stać się przebiegłym łowcą formuł, należy z karty Deweloper wybrać polecenie Kod→
Visual Basic (w wersjach wcześniejszych jest to polecenie Narzędzia→Makro→Edytor Visual
Basic) lub nacisnąć klawisze Alt/Option+F11, po czym wybrać Insert→Module i wpisać
następującą funkcję:

Function IsFormula(Check_Cell As Range)
  IsFormula = Check_Cell.HasFormula
End Function

Po jej wpisaniu należy zamknąć okno (naciskając w tym celu Alt/ +Q lub klikając przy-
cisk Zamknij na pasku tytułu okna). Od teraz funkcja ta będzie dostępna w każdej komórce
każdego arkusza aktywnego skoroszytu, a w celu jej wywołania trzeba będzie wpisać
jedynie formułę =IsFormula($A$1). Do funkcji tej można również uzyskać dostęp, wybie-
rając polecenie Formuły→Biblioteka funkcji→Wstaw funkcję (wcześniej Wstaw→Funkcja…),
w polu kategorii funkcji wskazując wartość Użytkownika i na liście funkcji zaznaczając po-
zycję IsFormula.

Formuła ta zwróci wartość PRAWDA, jeśli w komórce, do której będzie się odwoływać,
będzie znajdować się formuła, a wartość FAŁSZ w przeciwnym razie. Zwracaną wartość
logiczną można zastosować wraz z formatowaniem warunkowym w taki sposób, by
wszystkie formuły zostały automatycznie wyróżnione przy użyciu wybranego formatu.
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Najważniejszą zaletą tej metody jest fakt, że możliwości wyszukiwania formuł w arkuszach
będą miały charakter dynamiczny. Oznacza to, że jeśli formuła zostanie w danej komórce
wpisana lub z niej usunięta, odpowiednio zmienione zostanie również formatowanie.
Poniżej przedstawiamy czynności, które należy w tym celu wykonać.

Najpierw trzeba zaznaczyć zakres komórek arkusza, powiedzmy A1:J500, a w później-
szym czasie, gdy w arkuszu znajdzie się więcej formuł, odpowiednio go rozszerzyć.

Nie należy zaznaczać całego arkusza, ponieważ może to niepotrzebnie
zmniejszyć wydajność działania całego skoroszytu.

Gdy komórki zostaną zaznaczone, a komórką aktywną zaznaczenia będzie A1, należy
wybrać polecenie Narzędzia główne→Formatowanie warunkowe→Nowa reguła…→Użyj for-
muły do określenia komórek, które należy sformatować i w polu Formatuj wartości, dla których
następująca formuła jest prawdziwa: wprowadzić formułę (w wersjach wcześniejszych należy
kliknąć polecenie Format→Formatowanie warunkowe…, zamiast opcji Wartość komórki jest
wybrać opcję Formuła jest i w polu formuły wpisać: =IsFormula(A1)). Następnie trzeba
kliknąć przycisk Formatuj… i zdefiniować pożądane formatowanie, które ma wskazywać
komórki zawierające formuły. Na koniec należy kliknąć przycisk OK i jeszcze raz OK.

Czasami po wpisaniu formuły w oknie dialogowym Formatowanie warunkowe
i kliknięciu przycisku OK Excel wstawi znaki cudzysłowu wokół formuły.
Będzie to znaczyło, że Excel potraktował wpisane wartości jako tekst, a nie
jako formułę. W takich przypadkach należy wrócić do okna Formatowanie
warunkowe, usunąć znaki cudzysłowu i kliknąć OK.

W tym momencie zdefiniowany format powinien zostać zastosowany we wszystkich
komórkach arkusza zawierających formuły. Jeśli w którejś z tych komórek zostanie wpisana
nowa wartość lub zostanie ona usunięta, formatowanie warunkowe zniknie. Analogicznie,
jeśli w dowolnej komórce należącej do wskazanego zakresu wpisana zostanie formuła,
komórka ta zostanie wyróżniona.

Dzięki temu prostemu sposobowi można znacznie ułatwić sobie pracę z arkuszem, a zwłasz-
cza skrócić czas potrzebny na jego utrzymywanie i modyfikowanie.

S P O S Ó B

20.
Wszystkie

Zliczanie lub sumowanie komórek
spełniających kryteria formatowania warunkowego
Gdy na ekranie będą już widoczne wyniki formatowania warunkowego, można pokusić się o napisanie
formuł odwołujących się jedynie do tych danych, które zostały warunkowo sformatowane. Excel nie uwzględnia
w swoich obliczeniach formatowania warunkowego, można jednak sprawić, że będzie to robił.

Użytkownicy Excela często pytają: „W jaki sposób można wykonać obliczenia jedynie na
tych komórkach, których tło ma określony kolor?”. Pytanie to słyszymy bardzo często,
ponieważ Excel nie udostępnia żadnej standardowej funkcji spełniającej takie zadanie.
Można jednak wykorzystać do tego celu własną funkcję, co opisano w części „Zliczanie
lub sumowanie komórek z określonym kolorze cieniowania” [Sposób 113.].
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Jedyny kłopot z funkcją zdefiniowaną przez użytkownika polega na tym, że nie potrafi
ona rozpoznać formatowania będącego efektem zdefiniowanego formatowania warunko-
wego. Jednak jeśli się trochę nad tym zastanowić, można osiągnąć pożądany wynik bez
pisania własnej funkcji.

Załóżmy, że mamy długą listę liczb, znajdującą się w komórkach $A$2:$A$100. Zasto-
sowaliśmy w nich formatowanie warunkowe, dzięki czemu wyróżniane są liczby należące
do przedziału od 10 do 20. Teraz należy odnaleźć wartości komórek spełniających zdefi-
niowane kryterium oraz obliczyć sumę wartości sformatowanych warunkowo. Nie trze-
ba zwracać uwagi na to, jaki konkretnie format warunkowy zdefiniowano, trzeba jednak
znać kryteria, na podstawie których komórki były wyróżniane (w naszym przypadku są
to komórki z wartościami z przedziału od 10 do 20).

Aby dodać do siebie wartości komórek spełniających odpowiednie — ale tylko jedno
— kryterium, można użyć funkcji SUMA.JEŻELI. Jeśli konieczne będzie uwzględnienie
więcej niż jednego kryterium, trzeba będzie użyć formuły tablicowej.

Można użyć następującej formuły:

=SUMA(JEŻELI($A$2:$A$100>10;JEŻELI($A$2:$A$100<20;$A$2:$A$100)))

Wpisując formuły tablicowe, nie należy naciskać klawisza Enter, lecz klawisze
Ctrl+Shift+Enter. Wówczas Excel zamknie definicję formuły w nawiasach
klamrowych, a więc będzie ona miała postać:

{=SUMA(JEŻELI($A$2:$A$100>10;JEŻELI($A$2:$A$100<20;$A$2:$A$100)))}

Jeśli nawiasy klamrowe wpisze się samemu, formuła nie zadziała — czynność
tę musi wykonać sam Excel.

Trzeba również zaznaczyć, że używanie formuł tablicowych, posiadających
zbyt wiele odwołań do dużych zakresów komórek, może znacznie zmniejszyć
tempo obliczeń wykonywanych przez Excela.

Więcej informacji na temat formuł tablicowych można znaleźć na stronie WWW pod
adresem http://www.ozgrid.com/Excel/arrays.htm.

Rozwiązanie alternatywne
Inne możliwe rozwiązanie polega na użyciu dodatkowej kolumny (na przykład kolumny B)
odwołującej się do komórek w kolumnie A. Odwołanie to powinno zwracać w kolumnie
B odpowiedni wynik tylko wówczas, gdy wartość będzie spełniać zdefiniowane kryterium,
na przykład >10, <20. W tym celu należy wykonać czynności opisane poniżej.

Najpierw trzeba zaznaczyć komórkę B1 i wpisać w niej następującą formułę:

=JEŻELI(ORAZ(A2>10;A2<20);A2;"")

Formułą tą należy wypełnić wszystkie komórki aż do B100. Po wpisaniu wartości w kolum-
nie B powinny pojawić się wartości należące do przedziału od 10 do 20.
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Aby szybko skopiować formułę aż do ostatniego używanego wiersza kolumny
sąsiedniej, należy wpisać formułę w pierwszej komórce (B2), ponownie ją
zaznaczyć i dwukrotnie kliknąć uchwyt wypełnienia. Ten sam efekt można
osiągnąć, przechodząc na kartę Narzędzia główne i wybierając polecenie
Edycja→Wypełnienie→W dół (w starszych wersjach Edycja→Wypełnij→W dół).

Teraz można już zaznaczyć dowolną komórkę, w której powinna się pojawić wartość sumy,
i użyć w niej standardowej funkcji SUMA, która tę wartość obliczy. (W razie potrzeby można
ukryć kolumnę B, by dodatkowa kolumna, pełna wartości zwróconych przez formułę,
stała się niewidoczna).

Przedstawione metody pozwolą w pełni zrealizować postawione zadanie, jednak Excel
udostępnia jeszcze jedną funkcję umożliwiającą zdefiniowanie dwóch lub więcej kryte-
riów. Funkcja ta należy do kategorii Bazy danych i nosi nazwę BD.SUMA. Aby sprawdzić
jej działanie, ponownie wykorzystamy ten sam zbiór liczb z komórek A2:A100. Najpierw
należy zaznaczyć zakres komórek C1:D2 i nadać mu nazwę KryteriumSumy, wpisując ją
w polu nazwy z lewej strony paska formuły. Następnie trzeba zaznaczyć komórkę C1 i wpi-
sać =$A$1, czyli odwołanie do pierwszej komórki arkusza. Formułę tę należy skopiować
również do komórki D1 — w efekcie powinny powstać dwie kopie nagłówka kolumny A.
Kopie te zostaną użyte jako nagłówki kryterium dla funkcji BD.SUMA (C1:D2), które nazwa-
liśmy KryteriumSumy.

W komórce C2 trzeba wpisać >10, a w komórce D2 <20. Natomiast w komórce, w której
ma być widoczny wynik, należy wpisać następującą formułę:

=BD.SUMA($A$1:$A$100;$A$1;KryteriumSumy)

Użycie funkcji BD.SUMA to zalecana i najbardziej wydajna metoda pracy z komórkami
spełniającymi określone kryteria. W odróżnieniu od tablic, wbudowane funkcje bazy danych
zostały zaprojektowane właśnie do takich celów. Dzięki temu nawet gdy odwołują się
one do naprawdę dużych zakresów komórek i w arkuszu znajduje się ich znaczna liczba,
powodowany przez nie spadek prędkości i wydajności obliczeń jest niewielki w porów-
naniu z negatywnymi efektami używania formuł tablicowych.

S P O S Ó B

21.
Wszystkie

Wyróżnianie co drugiego wiersza lub kolumny
Często widzi się arkusze Excela, w których wiersze są na przemian w dwóch kolorach: na przykład wiersze
o numerach nieparzystych są białe, a wiersze o numerach parzystych szare. Efekt taki osiąga się dzięki
formatowaniu warunkowemu.

Stosowane na przemian dwa kolory lub cieniowanie nadaje arkuszom profesjonalny wygląd
i sprawia, że dane są bardziej czytelne. Formatowanie takie można ustawić ręcznie, lecz
nietrudno zgadnąć — a niektórzy Czytelnicy zapewne sami się o tym przekonali — że
zadanie to jest czasochłonne, a sam arkusz wymaga ciągłego uaktualniania w miarę do-
dawania i usuwania wierszy z tabeli. Oczywiście trzeba się przy tym wykazać również
anielską cierpliwością. Na szczęście dzięki formatowaniu warunkowemu można uzyskać
profesjonalny wygląd arkusza bez nadwerężania własnej cierpliwości.
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Załóżmy, że dane zapisane są komórkach z zakresu A1:H100. Komórki te należy zazna-
czyć, rozpoczynając od komórki A1, by była ona aktywną komórką zaznaczenia. Następnie
trzeba wybrać polecenie Narzędzia główne→Formatowanie warunkowe→Nowa reguła…→Użyj
formuły do określenia komórek, które należy sformatować, a następnie w polu Formatuj warto-
ści, dla których następująca formuła jest prawdziwa wpisać poniższą formułę (w starszych
wersjach należy wybrać polecenie Format→Formatowanie warunkowe… i na liście rozwijanej,
której domyślną wartością jest Wartość komórki jest, wybrać pozycję Formuła jest, a następnie
w polu formuły wpisać poniższą formułę), widoczną również na rysunku 2.5:

=MOD(WIERSZ();2)

Rysunek 2.5. Nowe okno dialogowe Formatowanie warunkowe z wpisaną formułą MOD,
służącą do formatowania co drugiego wiersza z zakresu komórek

W kolejnym kroku należy kliknąć przycisk Formatuj… i wybrać format, jaki ma zostać
zastosowany w co drugim wierszu, po czym kliknąć OK i jeszcze raz OK. Zdefiniowany
format powinien zostać zastosowany w co drugim wierszu z zakresu A1:H100, a użyt-
kownik nie będzie musiał wykazywać się anielską cierpliwością.

Jeśli odpowiedni format trzeba zastosować w co drugiej kolumnie, a nie wierszu, należy
użyć następującej formuły:

=MOD(NR.KOLUMNY();2)

Metoda ta pozwala na szybkie i łatwe zastosowanie wybranego formatu w co drugim
wierszu lub kolumnie, lecz nie jest ona metodą dynamiczną — wiersze, które nie będą
zawierać danych, również będą formatowane. Arkusz będzie przez to wyglądał niepo-
rządnie, a jego czytanie będzie utrudnione. Aby wyróżnianie co drugiego wiersza lub
kolumny przebiegało w sposób dynamiczny, trzeba zastosować nieco bardziej wyrafi-
nowane rozwiązanie.



SPOSÓB
22. Tworzenie efektów 3D w tabelach lub komórkach

74 | Sposoby na wbudowane mechanizmy Excela

Wyróżnianie dynamiczne
Ponownie należy zaznaczyć zakres A1:H100, upewniając się, że A1 będzie komórką aktyw-
ną. Następnie należy wybrać polecenie Narzędzia główne→Formatowanie warunkowe→Nowa
reguła…→ Użyj formuły do określenia komórek, które należy sformatować, a następnie w polu
Formatuj wartości, dla których następująca formuła jest prawdziwa (w starszych wersjach należy
wybrać polecenie Format→Formatowanie warunkowe… i na liście rozwijanej, której domyślną
wartością jest Wartość komórki jest, wybrać pozycję Formuła jest) wpisać poniższą formułę:

=ORAZ(MOD(WIERSZ();2);ILE.NIEPUSTYCH($A1:$H1))

Należy zwrócić uwagę, że w formule tej odwołanie do kolumn ma charakter
bezwzględny (o czym decyduje znak dolara), natomiast odwołanie do wierszy
jest względne.

Następnie należy kliknąć przycisk Formatuj… i wskazać pożądane formatowanie, po czym
kliknąć przycisk OK i jeszcze raz OK. W wierszach z zakresu A1:H100, w których nie ma
danych, formatowanie warunkowe nie zostanie zastosowane. Jeśli z któregoś wiersza dane
zostaną usunięte, wiersz ten również nie będzie podlegał formatowaniu. Jeśli do którejś
z komórek z zakresu zostanie wpisana jakaś wartość, zostanie ona uwzględniona w for-
matowaniu warunkowym.

Rozwiązanie to działa, ponieważ formuła formatowania warunkowego musi zwrócić war-
tość PRAWDA lub FAŁSZ. W języku formuł Excela 0 jest równoznaczne z wartością logiczną
FAŁSZ, natomiast każda wartość większa od zera ma wartość logiczną PRAWDA. Zatem
formuła =MOD(WIERSZ();2) zwróci wartość 0 (FAŁSZ) lub liczbę większą od zera.

Funkcja WIERSZ jest funkcją zmienną, która zawsze zwraca numer wiersza komórki,
w której ją wpisano. Funkcja MOD natomiast zwraca resztę z dzielenia pierwszej liczby
przez drugą. W formule użytej w naszym sposobie dzielimy numer wiersza przez 2,
dzięki czemu we wszystkich wierszach o numerach parzystych formuła zwróci wartość 0,
a w wierszach o numerach nieparzystych — zawsze wartość większą od zera.

Zagnieżdżenie funkcji WIERSZ() i ILE.NIEPUSTYCH w funkcji ORAZ powoduje, że ta ostat-
nia zwróci wartość PRAWDA jedynie wówczas, gdy obie funkcje MOD i ILE.NIEPUSTYCH
zwrócą wartość PRAWDA lub dowolną liczbę większą od zera. ILE.NIEPUSTYCH zwraca
liczbę komórek niepustych.

S P O S Ó B

22.
Wszystkie

Tworzenie efektów 3D w tabelach lub komórkach
Gdy w programach lub aplikacjach takich jak Excel spotyka się przyciągające uwagę efekty trójwymiarowości,
tak naprawdę widzi się jedynie złudzenie wywołane odpowiednio zastosowanym formatowaniem.
Łatwo jest samemu stworzyć takie złudzenie, stosując odpowiednie formatowanie w komórce lub zakresie
komórek. Wraz z wypuszczeniem na rynek Excela 2007 dostępne stały się style komórek, dzięki czemu
można stworzyć efekty 3D i zapisać je do późniejszego wykorzystania.

Na początek zajmiemy się prostym przykładem, w którym w komórce zastosujemy efekt
trójwymiarowości. Dzięki niemu komórka będzie wyglądać, jakby była nieco podniesiona
— jak przycisk. W pustym arkuszu należy zaznaczyć komórkę D5 (zaznaczamy komórkę
D5, ponieważ nie leży ona na krawędzi arkusza) i z grupy opcji Komórki znajdującej się
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na karcie Narzędzia główne wybrać polecenie Format→Formatuj komórki…→Obramowanie
(w starszych wersjach jest to polecenie Format→Komórki…→ Obramowanie). W polu Linia
należy wskazać drugą najgrubszą linię i upewnić się, że jej kolorem jest czarny (lub
Automatyczny, jeśli nie zmieniono domyślnej wartości). Następnie trzeba kliknąć obramo-
wanie z prawej strony oraz obramowanie dolne. W polu Linia trzeba teraz ustawić kolor
linii na biały, pozostawić styl drugiej najgrubszej linii i kliknąć pozostałe dwa obramowania
komórki: obramowanie górne i lewostronne. W oknie dialogowym Formatowanie komórek
trzeba następnie kliknąć zakładkę Wypełnienie (wcześniej Desenie) i jako kolor cieniowania
komórki wskazać kolor szary. W kolejnym kroku należy kliknąć OK i zaznaczyć komórkę
inną niż D5. Komórka D5 będzie teraz podniesiona, dzięki czemu będzie przypominać
przycisk. A wszystko to jedynie dzięki obramowaniom i cieniowaniu.

Jeżeli dla zabawy lub zwiększenia różnorodności komórka ma wyglądać, jakby była wci-
śnięta lub wcięta, należy zaznaczyć komórkę E5 (ponieważ jest to następna komórka po D5,
a my wykonujemy następne ćwiczenie), wybrać polecenie Narzędzia główne→Komórki→
Format→Formatuj komórki…→Obramowanie (w starszych wersjach należy kliknąć polecenie
Format→Komórki…→ Obramowanie), na liście stylów linii zaznaczyć drugie najgrubsze
obramowanie i upewnić się, że jego kolorem jest czarny.

Formatowanie to należy zastosować do górnego i lewostronnego obramowania komórki.
Następnie należy wybrać kolor biały i białą linią obramować komórkę z prawej strony
i u dołu, po czym kliknąć zakładkę Desenie i zmienić format komórki na szary. Na koniec
należy kliknąć OK — komórka E5 powinna teraz wyglądać, jakby była wciśnięta. Wrażenie
to jest jeszcze mocniejsze dzięki sąsiadującej z nią komórce D5, w której zastosowaliśmy
efekt podniesienia.

Jeżeli jest się zadowolonym ze stylu, jaki się stworzyło, należy wybrać polecenie
Narzędzia główne→Style→Style komórki→Nowy styl komórki…, podać nazwę
nowego stylu oraz kliknąć przycisk OK. Należy pamiętać, że style komórek
zapisywane są w bieżącym skoroszycie, ale można uwzględniać style z innych
skoroszytów. Opcja ta nie jest dostępna w wersjach wcześniejszych niż
Excel 2007. Aby zachować style w starszych wersjach Excela, należy użyć
polecenia Format→Style.

Efekt 3D w tabeli danych
W kolejnym kroku wykorzystamy to samo rozwiązanie, aby pokazać kilka efektów, które
można zastosować w tabelach lub arkuszach w celu nadania im wrażenia trójwymiaro-
wości.

Najpierw należy zaznaczyć komórki D5 i E5 i na karcie Narzędzia główne w grupie opcji
Schowek (w starszych wersjach na standardowym pasku narzędzi) kliknąć ikonę Malarz
formatów (ikonę pędzla). Następnie trzeba kliknąć lewym przyciskiem myszy na komór-
ce F5 i przy wciśniętym przycisku przeciągnąć zaznaczenie aż do komórki J5, po czym
zwolnić przycisk.

Następnie trzeba zaznaczyć komórki D5:J5 i ponownie na standardowym pasku narzę-
dzi kliknąć ikonę Malarz formatów, po czym zaznaczyć komórkę D6 poprzez wciśnięcie
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lewego przycisku myszy, przeciągnąć zaznaczenie aż do komórki J15 i zwolnić przy-
cisk. W efekcie powinniśmy otrzymać efekt przedstawiony na rysunku 2.6.

Rysunek 2.6. Efekt 3D zastosowany w zakresie komórek

Aby zachować stworzony styl tabeli, należy wybrać polecenie Narzędzia
główne→Style→Formatuj jako tabelę→Nowy styl tabeli.... W starszych wersjach
Excela (przed wersją 2007) opcja ta nie jest dostępna.

Aby zwiększyć wyrazistość efektu trójwymiarowości, zastosowaliśmy dość grube obra-
mowanie, można jednak trochę ten efekt złagodzić, wybierając styl cieńszej linii. Można
również wybrać jeden z pozostałych stylów linii, aby osiągnąć jeszcze ciekawszy efekt.
Najlepsze rozwiązanie znajduje się metodą prób i błędów, wypróbowując w pustym arku-
szu kolejne kombinacje, aż do osiągnięcia pożądanego efektu. Ograniczeniem jest jedynie
wyobraźnia i gust.

Efekty trójwymiarowości zwiększają czytelność arkuszy i nadają im profesjonalny
wygląd, lecz zawsze należy pamiętać, że nadużywanie tego efektu może
przynieść skutek odwrotny od zamierzonego — wszak wszystko trzeba robić
z umiarem.

Aby pójść jeszcze krok dalej i stosować efekt trójwymiarowości w sposób automatyczny
i dynamiczny, można połączyć efekt 3D i formatowanie warunkowe. Dzięki temu forma-
towanie będzie przebiegać automatycznie przy użyciu zdefiniowanego stylu.

S P O S Ó B

23.
Wszystkie

Włączanie i wyłączanie formatowania warunkowego
i sprawdzania poprawności danych przy użyciu pola wyboru
Sprawdzanie poprawności danych znacznie zmniejsza prawdopodobieństwo, że któryś z użytkowników
przypadkowo wpisze nieprawidłowe dane. Czasami jednak zachodzi potrzeba ułatwienia wpisywania
danych, które w innej sytuacji byłyby oznaczane jako nieprawidłowe przez formatowanie warunkowe
lub których wpisanie byłoby zablokowane przez mechanizm sprawdzania poprawności.

Pierwsze przychodzące na myśl rozwiązanie mające na celu umożliwienie użytkownikom
wpisywania danych, które w innej sytuacji byłyby oznaczone jako niepoprawne, to usunię-
cie z komórek formatowania warunkowego i (lub) mechanizmu sprawdzania poprawności
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danych. Istnieje jednak prostszy sposób: z mechanizmem sprawdzania poprawności danych
można połączyć zwykłe pole wyboru z paska narzędzi Formularze.

W tym przykładzie w zakresie komórek tak zdefiniujemy formatowanie warunkowe, aby
wartości występujące więcej niż jeden raz były wyróżniane i łatwo było je odszukać. Zakła-
damy, że tabela danych zajmuje zakres komórek $A$1:$H$100. Aby warunkowo sforma-
tować ten zakres danych w taki sposób, by wartości powtarzające się były wyróżniane,
trzeba wykonać kilka czynności.

Najpierw należy zaznaczyć komórkę K1 i nadać jej nazwę ŁączePolaWyboru, wpisując ją
w polu Nazwa znajdującym się z lewej strony paska formuł i naciskając klawisz Enter.
Następnie należy kliknąć w komórkę I3 i wybrać polecenie Deweloper→Wstaw→Formanty
formularza→Pole wyboru (w starszych wersjach, jeśli pasek narzędzi Formularze nie jest
jeszcze widoczny, należy kliknąć prawym przyciskiem myszy na dowolnym pasku na-
rzędzi i wybrać Formularze, a następnie wybrać z niego ikonę Pole wyboru). Później trzeba
kliknąć w arkuszu w którejś z komórek, która nie należy do zakresu A1:H100, i umieścić
w niej pole wyboru.

W kolejnym kroku trzeba kliknąć na polu wyboru prawym przyciskiem myszy i wybrać
polecenie Formatuj formant…→Formant, po czym w polu Łącze komórki wpisać nazwę
ŁączePolaWyboru i kliknąć OK. Następnie należy zaznaczyć komórkę A1 i przeciągnąć
myszą zaznaczenie do komórki H100. Ważne jest, by komórka A1 była aktywną komórką
zaznaczenia. Należy wybrać polecenie Narzędzia główne→Formatowanie warunkowe→
Nowa reguła…→Użyj formuły do określenia komórek, które należy sformatować i w polu For-
matuj wartości, dla których następująca formuła jest prawdziwa (we wcześniejszych wersjach
należy wybrać polecenie Format→Formatowanie warunkowe… i w polu o wartości Wartość
komórki jest wybrać pozycję Formuła jest) wpisać następującą formułę (widoczną również
na rysunku 2.7):

=ORAZ(LICZ.JEŻELI($A$1:$H:$100;A1)>1;ŁączePolaWyboru)

Rysunek 2.7. Okno dialogowe Formatowanie warunkowe z wpisaną formułą warunkowego formatowania
komórek zawierających powtarzające się dane
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Następnie trzeba kliknąć przycisk Formatuj… i na zakładce Desenie wskazać kolor, jakim
mają być wyróżniane dane powtarzające się. Na koniec należy kliknąć przycisk OK i jesz-
cze raz OK.

Jeśli pole wyboru umieszczone w arkuszu będzie zaznaczone, wartością łącza komórki
K1 (ŁączePolaWyboru) będzie PRAWDA i wszystkie wartości powtarzające się w zakresie
$A$1:$H$100 zostaną wyróżnione. Po usunięciu zaznaczenia pola wyboru łącze komórki
(ŁączePolaWyboru) będzie miało wartość FAŁSZ i duplikaty nie będą wyróżniane.

Pole wyboru można przełączać, dzięki czemu możemy przy jego użyciu włączać i wyłączać
w arkuszu formatowanie warunkowe bez konieczności każdorazowego odwoływania się
do okna dialogowego Formatowanie warunkowe. Tę samą zasadę można zastosować w przy-
padku sprawdzania poprawności danych, również używając formuły.

Sposób ten działa dzięki zastosowaniu funkcji ORAZ. W funkcji tej muszą zostać spełnione
dwa warunki: funkcja LICZ.JEŻELI($A$1:$H$100;A1)>1 musi mieć wartość PRAWDA
oraz łącze komórki pola wyboru (ŁączePolaWyboru) również musi mieć wartość PRAWDA.
Inaczej mówiąc, funkcja ORAZ zwróci wartość PRAWDA, jeśli obydwa warunki będą miały
wartość PRAWDA.

S P O S Ó B

24.
Wszystkie

Obsługa kilku list przy użyciu pola kombi
W trakcie pracy z kilkoma listami można wymuszać ich przełączanie, używając do tego przycisków opcji
oraz pola kombi.

Excel udostępnia użytkownikom szereg sposobów wybierania pozycji z listy na przykład
nazw, produktów, dni tygodnia — zależnie od tego, czego lista dotyczy. Aby jednak uzy-
skać dostęp jednocześnie do więcej niż jednej listy, trzeba czasem użyć trzech oddzielnych
kontrolek, na przykład pól kombi z grupy narzędzi Formanty formularza (w starszych
wersjach z paska narzędzi Formularze).

Istnieje jednak inna możliwość: można użyć pola kombi w połączeniu z przyciskami opcji
(nazywanymi również przełącznikami i również dostępnymi na pasku narzędzi Formu-
larze) w taki sposób, by lista zmieniała się zgodnie z wybranym przyciskiem opcji. Aby
zobaczyć, jak to działa, należy najpierw w nowym arkuszu, w komórkach z zakresu A1:A7
wpisać liczby od 1 do 7, w komórkach B1:B7 wpisać dni tygodnia, na pierwszym miejscu
umieszczając Poniedziałek, a na ostatnim wpisując Niedziela, a w komórkach C1:C7
wpisać nazwy miesięcy z zakresu Styczeń–Lipiec.

Wykonanie tego zadania znacznie ułatwią narzędzia autowypełniania
znajdujące się w Excelu. Najpierw w komórce A1 należy wpisać 1, zaznaczyć
tę komórkę, nacisnąć klawisz Ctrl (  na komputerach Macintosh) i lewym
przyciskiem myszy kliknąć uchwyt wypełniania. Następnie, trzymając wciśnięte
jednocześnie klawisz Ctrl i lewy przycisk myszy, trzeba przeciągnąć myszą
do wiersza numer 7. Excel sam wówczas wpisze odpowiednie liczby. Następnie
w komórce B1 należy wpisać Poniedziałek i dwukrotnie kliknąć w niej
uchwyt wypełnienia, po czym w komórce C1 trzeba wpisać Styczeń i znów
dwukrotnie kliknąć w niej uchwyt wypełnienia. Excel samodzielnie wpisze
pozostałe nazwy dni tygodnia i miesięcy.
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W dalszej kolejności trzeba wybrać polecenie Deweloper→Formanty→Wstaw→Formanty
formularza (w starszych wersjach należy kliknąć polecenie Widok→Paski narzędzi→Formularze)
i kliknąć przycisk opcji, po czym kliknąć w trzech dowolnych miejscach arkusza, umiesz-
czając w nich trzy przyciski opcji.

Następnie należy postępować w ten sam sposób, ale tym razem w grupie Formanty formula-
rza trzeba kliknąć pole kombi i ponownie kliknąć myszą w dowolnym miejscu arkusza,
aby umieścić w nim to pole. Używając uchwytów przeciągania, można odpowiednio
ustawić rozmiar pola kombi, a następnie bezpośrednio pod nim trzeba umieścić przyciski
opcji.

W kolejnym kroku trzeba kliknąć prawym przyciskiem myszy na pierwszym przycisku
opcji, wybrać polecenie Edytuj tekst i w miejsce tekstu Przycisk opcji 1 wpisać słowo Liczby.
Tę samą czynność należy wykonać dla Przycisku opcji 2, nadając mu nazwę Dni tygodnia
oraz dla Pola opcji 3, nadając mu nazwę Miesiące. Efekt docelowy przedstawiono na ry-
sunku 2.8.

Rysunek 2.8. Pole kombi dla kilku list sterowane przyciskami opcji

Trzymając wciśnięty klawisz Ctrl, należy kliknięciami wyróżnić każdy z trzech przycisków
opcji, po czym kliknąć prawym przyciskiem myszy i wybrać polecenie Formatuj formant…→
Formant (na komputerach Macintosh można wybrać polecenie View→Toolbars→Drawings
i użyć narzędzia Select Objects, aby wybrać grupę). Jako łącze komórki trzeba wskazać
komórkę $F$1 (odwołanie to musi mieć charakter bezwzględny, to znaczy musi zawierać
znaki dolara).

W komórce E6 należy wpisać następującą formułę:

=ADRES(1;$F$1)&":"&ADRES(7;$F$1)

Następnie należy wybrać polecenie Formuły→Nazwy zdefiniowane→Definiuj nazwę (w po-
przednich wersjach Wstaw→Nazwa→Definiuj…), w polu Nazwa (wcześniej Nazwy w skoro-
szycie:) wpisać MójZakres, a w polu Odwołuje się do: wpisać:

=ADR.POŚR($E$6)
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Należy kliknąć przycisk OK, po czym prawym przyciskiem myszy kliknąć pole kombi
i wybrać polecenie Formatuj formant…→Formant. Jako zakres wejściowy trzeba wpisać
MójZakres, jako łącze komórki podać $G$1 i kliknąć przycisk OK. Powinna teraz istnieć
możliwość zaznaczenia któregoś z przycisków opcji, a zawartość pola kombi powinna
zmieniać się automatycznie zależnie od tego, który przycisk został kliknięty.

Wykorzystując przedstawiony sposób we własnym arkuszu, dobrze jest użyć w charakterze
łączy i list pola kombi komórek znajdujących się poza zakresem ekranu. Można nawet
ukryć te komórki przed użytkownikiem, aby łącza cały czas znajdowały się tam, gdzie
powinny. Ponadto trzeba zmodyfikować definicje obydwu funkcji ADRES w taki sposób, by
zawierały one odpowiednie zakresy komórek. W funkcji ADRES, użytej w przedstawionym
przykładzie, wartość 1 oznacza numer pierwszego wiersza listy, a wartość 7 oznacza numer
ostatniego jej wiersza.

S P O S Ó B

25.
Wszystkie

Tworzenie list sprawdzania poprawności zmieniających się
zależnie od wartości na innej liście
Wymogi sprawdzania poprawności mogą być uzależnione od kontekstu, w jakim weryfikacja jest
przeprowadzana. Można utworzyć arkusz, w którym jedna lista sprawdzania poprawności będzie się
zmieniać zależnie od wyboru dokonanego na drugiej liście.

Aby móc wykorzystać niniejszy sposób, najpierw trzeba wypełnić arkusz danymi. W pustym
arkuszu o nazwie Listy należy zaznaczyć komórkę A1 i wpisać w niej nagłówek Obiekty,
a w komórce B1 wpisać nagłówek Odpowiadająca lista. W komórkach A2:A5 należy
wpisać słowo Puszka, w komórkach A6:A9 słowo Kanapa, w komórkach A10:A13 słowo
Prysznic, a w komórkach A14:A17 słowo Samochód. Następnie w kolejnych komórkach od
B2 do B17 trzeba wpisać następujące słowa (odpowiadające liście Obiekty): Cyna, Stal,
Otwieracz, Wieko, Łóżko, Siedzenie, Salon, Poduszka, Deszcz, Gorący, Zimny, Ciepły,
Wycieczka, Podróż, Maska i Bagażnik.

W komórce C1 należy wpisać nagłówek Lista sprawdzania, po czym w celu utworzenia
listy pozycji unikatowych w komórce C2 należy wpisać Puszka, w komórce C3 Kanapa,
w C4 Prysznic i w C5 Samochód.

Aby utworzyć listę pozycji unikatowych, można również użyć opcji Filtr
zaawansowany. W tym celu należy zaznaczyć komórki A1:A17, wybrać polecenie
Dane→Sortowanie i filtrowanie→Zaawansowane (w starszych wersjach jest
to polecenie Dane→Filtr…→Filtr zaawansowany), po czym zaznaczyć pole
wyboru Tylko unikatowe rekordy oraz opcję Filtruj listę na miejscu i kliknąć
przycisk OK. Następnie trzeba zaznaczyć komórki A2:A14 (obejmując
zaznaczeniem również komórki ukryte) i skopiować je oraz wkleić do komórki
A18. Na końcu należy wybrać polecenie Dane→Filtr…→Pokaż wszystko,
zaznaczyć listę obiektów unikatowych oraz wyciąć i wkleić ją do komórki A2.
W ten sposób uzyskamy odpowiednią listę.

W kolejnym kroku trzeba wybrać polecenie Formuły→Nazwy zdefiniowane→Menedżer nazw,
kliknąć przycisk Nowy… (w wersjach wcześniejszych należy wybrać polecenie Wstaw→
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Nazwa→Definiuj…) i w polu Nazwa: (wcześniej Nazwy w skoroszycie:) wpisać słowo Obiekty,
natomiast w polu Odwołuje się do: wpisać poniższą formułę i kliknąć przycisk Dodaj:

=PRZESUNIĘCIE(Listy!$A$2;0;0;ILE.NIEPUSTYCH(Listy!$A$1:$A$20);1)

Następnie należy kliknąć przycisk Nowy… (w poprzednich wersjach Dodaj…). W polu
Nazwa: (wcześniej Nazwy w skoroszycie:) należy wpisać nazwę ListaWartości, a w polu
Odwołuje się do: odwołanie $C$2:$C$5, po czym kliknąć Zamknij. W dalszej kolejności
należy wstawić kolejny arkusz, nadać mu nazwę Arkusz1 i zakasać rękawy przed przy-
stąpieniem do kolejnego etapu pracy.

W arkuszu o nazwie Arkusz1 należy wybrać polecenie Formuły→Nazwy zdefiniowane→
Menedżer nazw, kliknąć przycisk Nowy… (w poprzednich wersjach trzeba kliknąć polecenie
Wstaw→Nazwa→Definiuj…), w polu Nazwa: (Nazwy w skoroszycie:) wpisać słowa Odpowia-
dającaLista, a w polu Odwołuje się do: wpisać poniższą, dość długą formułę, po czym klik-
nąć przycisk Dodaj:

=PRZESUNIĘCIE(ADR.POŚR(ADRES(PODAJ.POZYCJĘ(Wart1Komórka;
Obiekty;0)+1;2;;;"Listy"));0;0;LICZ.JEŻELI(Obiekty;Wart1Komórka;1)

Następnie należy kliknąć przycisk Nowy… (wcześniej Dodaj…) w polu Nazwa: (wcześniej
Nazwy w skoroszycie:) i wpisać w nim słowo Wart1Komórka, po czym w polu Odwołuje się do:
wpisać $D$6 i kliknąć Dodaj. Ponownie trzeba kliknąć w polu Nazwy w skoroszycie:, wpisać
słowo Wart2Komórka, w polu Odwołuje się do: wpisać $E$6 i znów kliknąć przycisk OK.
Należy kliknąć przycisk Zamknij (w poprzednich wersjach przycisk OK), aby powrócić do
arkusza Arkusz1, po czym zaznaczyć komórkę $D$6.

Prezentowana procedura jest długa, ale już zbliżamy się do jej końca.

Na karcie Dane z grupy poleceń Narzędzia danych należy wybrać polecenie Poprawność
danych, a następnie upewnić się, że wyświetlona jest zakładka Ustawienia (w starszych wer-
sjach należy wybrać polecenie Dane→Sprawdzanie poprawności…→Ustawienia). W polu
Dozwolone: wybrać wartość Lista, a w polu Źródło: wpisać =Wart1Komórka. Trzeba jeszcze
upewnić się, że zaznaczone jest pole wyboru Rozwinięcia w komórce i kliknąć przycisk OK.

W kolejnym kroku należy zaznaczyć komórkę E6 i znów na karcie Dane z grupy pole-
ceń Narzędzia danych wybrać polecenie Poprawność danych (w starszych wersjach Dane→
Sprawdzanie poprawności…), w polu Dozwolone: wybrać pozycję Lista, w polu Źródło: wpi-
sać =OdpowiadającaLista i, po upewnieniu się, że zaznaczone jest pole wyboru Rozwinięcia
w komórce, kliknąć OK.

Po dodaniu sprawdzania danych do komórki E6 użytkownik zobaczy
następujący komunikat: Źródło odwołuje się do błędu. Czy chcesz kontynuować?.
Należy nacisnąć przycisk Tak. Komunikat ten występuje, ponieważ komórka
D6 jest aktualnie pusta.

Na liście sprawdzania poprawności w komórce D6 trzeba wybrać jeden z obiektów — wów-
czas w komórce E6 lista sprawdzania poprawności zmieni się odpowiednio do wybranego
obiektu.
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Utworzyliśmy tym samym przyjazną dla użytkownika listę sprawdzania poprawności
danych (listę wyboru), widoczną na rysunku 2.9. Jej zawartość będzie się zmieniać auto-
matycznie w zależności od tego, jaka pozycja zostanie wybrana na drugiej liście wyboru.

Rysunek 2.9. Praca z dwiema odpowiadającymi sobie listami sprawdzania poprawności
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26.
Wszystkie

Usuwanie niechcianych znaków
przy użyciu polecenia Zamień…
W wyniku zaimportowania lub skopiowania i wklejenia danych pochodzących ze źródeł zewnętrznych
w arkuszu docelowym mogą pojawić się niepożądane znaki. Używając tego sposobu, można zaoszczędzić
czas, jaki trzeba by poświęcić na ich ręczne usuwanie.

Polecenie Excela Zamień… pomaga usunąć z arkusza niepożądane znaki, wymaga jednak
wykonania kilku dodatkowych czynności. Na przykład można się zdecydować na zamianę
w komórkach niechcianych znaków na znaki puste (czyli po prostu usunięcie niechcianych
znaków). W tym celu trzeba jednak znać kody znaków, które mają zostać usunięte. Każdy
znak ma swój własny kod, a w Excelu można go odczytać dzięki funkcji KOD. Funkcja ta
zwraca kod liczbowy pierwszego znaku występującego w podanym łańcuchu tekstowym,
odpowiadający zestawowi znaków używanemu w komputerze.

Aby wykorzystać ten sposób, należy zaznaczyć jedną z komórek zawierających niepożądany
znak, na pasku formuł wyróżnić ten znak i skopiować go do schowka. Następnie trzeba
zaznaczyć dowolną nieużywaną komórkę (na przykład A1) i wkleić do niej skopiowany
przed chwilą znak.

W innej komórce należy wpisać następującą formułę:

=KOD($A$1)

Wynikiem tej formuły będzie liczbowy kod niepożądanego znaku.

W kolejnym kroku należy zaznaczyć wszystkie dane i wybrać polecenie Narzędzia główne→
Edycja→Znajdź i zaznacz→Zamień… (w poprzednich wersjach Edycja→Zamień…), kliknąć
myszą w polu Znajdź:, nacisnąć klawisz Alt lub  i wpisać znak 0 oraz liczbowy kod
zwrócony przez funkcję KOD. Jeśli kodem tym jest na przykład liczba 163, trzeba nacisnąć
klawisz Alt lub  i wpisać 0163. Pole Zamień na: należy zostawić puste i nacisnąć klawisz
Zamień wszystko — wówczas wszystkie niechciane znaki odpowiadające podanemu liczbo-
wemu kodowi znaku zostaną w mgnieniu oka usunięte z arkusza. Przedstawioną procedurę
należy powtórzyć dla każdego niepożądanego znaku.
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27.
Wszystkie

Przekształcanie liczb zapisanych w tekście
w wartości liczbowe
Zawartość niektórych komórek, zwłaszcza tych zawierających dane zaimportowane, może wyglądać
jak dane liczbowe, nie można ich jednak czasem użyć w obliczeniach. Poniżej przedstawiamy kilka
sposobów, dzięki którym bez trudu można przekształcić takie „tekstowe” liczby w liczby prawdziwe.

Jak już wspominaliśmy, Excel domyślnie wyrównuje liczby do prawej strony, a tekst
domyślnie wyrównywany jest do strony lewej. Najprostszy sposób sprawdzenia, czy
w kolumnie, w której na pierwszy rzut oka zapisane są prawdziwe liczby, nie występują
przypadkiem liczby traktowane jako tekst, polega na: zaznaczeniu całej kolumny, przejściu
na kartę Narzędzia główne, uruchomieniu okna dialogowego opcji Wyrównanie poprzez klik-
nięcie dolnego prawego rogu grupy Wyrównanie, wybraniu polecenia Formatowanie komó-
rek→Wyrównanie (w poprzednich wersjach jest to polecenie Format→Komórki…→Wyrów-
nanie), upewnieniu się, że jako wyrównanie poziome ustawione jest domyślne wyrów-
nywanie Excela, czyli Ogólne, i kliknięciu OK. Następnie należy odpowiednio zwiększyć
szerokość kolumny — wszystkie prawdziwe liczby będą w niej wyrównane do strony
prawej, natomiast podejrzane liczby „tekstowe” będą wyrównane do strony lewej. Daty
również będą wyrównane do prawej, ponieważ rzeczywistą wartością każdej daty jest
zwykła liczba.

Wykorzystanie mechanizmu Wklej specjalnie
Gdy okaże się, że w kolumnie znajdują się liczby traktowane jako tekst, w prosty sposób
można przekształcić je wszystkie w prawdziwe liczby, które będą mogły zostać użyte przez
Excela w obliczeniach. W tym celu należy skopiować dowolną pustą komórkę, zaznaczyć
listę liczb, kliknąć prawym przyciskiem myszy i wybrać polecenie Wklej specjalnie…, po
czym w sekcji Wklej zaznaczyć Wartości. W sekcji Operacja należy zaznaczyć opcję Dodaj
i kliknąć przycisk OK.

Operacja ta spowoduje zamianę wszystkich liczb traktowanych jako tekst w prawdziwe
liczby. Jest to możliwe dzięki temu, że wartością pustej komórki jest 0, a gdy do liczby
traktowanej przez Excel jako tekst doda się dowolną liczbę, liczba tekstowa zostanie auto-
matycznie przekształcona w prawdziwą liczbę.

Wykorzystanie funkcji tekstowych
Takie samo podejście można zastosować w odniesieniu do niektórych standardowych
funkcji Excela, w szczególności do funkcji należących do kategorii Tekstowe. Zwykle, nawet
jeśli wynikiem zwracanym przez funkcję Tekstową Excela jest liczba, to i tak zostanie ona
zwrócona w postaci tekstu, a nie jako prawdziwa liczba.

Załóżmy, że mamy zakres komórek zaczynający się od komórki $A$1 i każda z nich zawie-
ra wartość pieniężną, po której znajduje się znak spacji i imię osoby. Wartość pieniężną
można wyodrębnić przy użyciu poniższej formuły, złożonej z dwóch funkcji tekstowych
LEWY i ZNAJDŹ:

=LEWY(A1;ZNAJDŹ(" ";A1)-1)
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Jeżeli w komórce znajdować się będzie wartość 22,70zł Daniel, wynikiem formuły
będzie 22,70zł. Wynik ten zostanie jednak zwrócony jako tekst, a nie jako prawdziwa
wartość liczbowa, domyślnie zatem będzie on wyrównany w komórce do lewej strony.

Można jednak zmodyfikować powyższą formułę w taki sposób, by jej wynikiem był nie
tekst, lecz prawdziwa liczba. W tym celu należy do wyniku tej formuły dodać 0:

=LEWY(A1;ZNAJDŹ(" ";A1)-1)+0

Dzięki temu wartość dotąd wyrażana w złotówkach zostanie zwrócona w postaci praw-
dziwej liczby i będzie domyślnie wyrównana do prawej strony. Teraz wystarczy już tylko
sformatować ją odpowiednio do własnych wymagań.
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28.
Wszystkie

Wyodrębnianie części numerycznej z zawartości komórki
Często zdarza się, że użytkownik pracuje z pozycjami listy, które składają się zarówno z tekstu, jak i liczb.
Wykorzystanie własnej funkcji pozwala na łatwe rozwiązanie tego problemu bez względu na długość ciągu
znaków.

Kolejny problem, z jakim można się spotkać w trakcie pracy z tekstem i liczbami, polega
na wymieszaniu w jednej komórce tekstu i liczb bez możliwości wyodrębnienia jedynie
liczbowej części danych. W takiej sytuacji można napisać własną funkcję służącą do wy-
odrębnienia z łańcucha znaków jedynie liczbowej jego części.

Aby utworzyć taką funkcję, należy nacisnąć Alt/Option+F11, wybrać polecenie Insert→
Module i wpisać poniższy kod:

Function ExtractNumber(rCell As Range)
Dim lCount As Long, l As Long
Dim sText As String
Dim lNum As String

sText = rCell

  For lCount = Len(sText) To 1 Step -1
    If IsNumeric(Mid(sText, lCount, 1)) Then
      l = l + 1
      lNum = Mid(sText, lCount, 1) & lNum
    End If

    If l = 1 Then lNum = CInt(Mid(lNum, 1, 1))
  Next lCount

ExtractNumber = CLng(lNum)
End Function

Aby wyjść z edytora i zapisać tę funkcję, należy nacisnąć Alt/ +Q. Funkcja ta pojawi się
w kategorii funkcji Użytkownika w oknie dialogowym Wklej funkcję (Shift+F3) i można jej
użyć w sposób przedstawiony na rysunku 2.10.
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Rysunek 2.10. Wyodrębnianie z łańcucha tekstu części liczbowej

Na rysunku 2.10 kolumna A zawiera mieszankę tekstu i liczb, w kolumnie B znajduje się
wynik wykonania funkcji ExtractNumber, a w kolumnie C zapisano tekst formuły użytej
w kolumnie B.

S P O S Ó B

29.
Wszystkie

Dostosowywanie komentarzy w komórkach
Komentarze w komórkach stanowią elektroniczny odpowiednik żółtej karteczki, którą można umieścić
w każdej komórce arkusza. Wiele osób zamieszcza komentarze, niewielu użytkowników jednak wie,
że można je dostosowywać do własnych upodobań.

Gdy komentarz wstawiany jest za pomocą polecenia Recenzja→Komentarze→Nowy komentarz
(w poprzednich wersjach za pomocą polecenia Wstaw→Komentarz), Excel domyślnie wstawi
w tym komentarzu również nazwę użytkownika komputera. Można to jednak zmienić, wy-
bierając polecenie Przycisk Office→Opcje programu Excel→Popularne (w starszych wersjach
należy wybrać polecenie Narzędzia→Opcje…→Ogólne). Nazwa użytkownika znajduje się
u dołu wyświetlonego okna dialogowego i zamiast niej można wpisać dowolny tekst, który
potem będzie domyślnie wyświetlany.

Choć komentarze zamieszczane w komórkach służą jedynie do wyświetlania informacji
przeznaczonych dla samego siebie lub innego użytkownika, można taki komentarz dosto-
sować w taki sposób, by lepiej oddawał intencje autora.

Aby upewnić się, że sposób ten zadziała, należy na pasku szybkiego dostępu dodać przycisk
zmieniający kształt. W tym celu należy wywołać polecenie Przycisk Office→Opcje programu
Excel→Dostosowywanie. Następnie z listy rozwijanej Wybierz polecenia z: należy wybrać
pozycję Karta Narzędzia grafiki SmartArt|Formatowanie. Następnie należy zlokalizować
narzędzie Zmień kształt, kliknąć je, a następnie kliknąć przycisk Dodaj, aby dodać je do
paska narzędzi Szybki dostęp. Na koniec należy kliknąć przycisk OK (w wersjach wcześniej-
szych nie ma możliwości dodania tego narzędzia, dlatego najpierw należy się upewnić, że
widoczny jest pasek narzędzi Rysowanie — w tym celu trzeba wybrać polecenie Widok→
Paski narzędzi→Rysowanie).

Następnie trzeba wstawić w komórce komentarz, zaznaczając w tym celu komórkę i wybie-
rając polecenie Recenzja→Komentarze→Nowy komentarz (w starszych wersjach należy wybrać
polecenie Wstaw→ Komentarz). Spowoduje to automatyczne przejście do trybu edycji, dzięki
czemu w polu komentarza można wpisywać tekst.

Tryb edycji należy wyłączyć, klikając na zewnętrznym obramowaniu okna komentarza.
Nie usuwając jego zaznaczenia, na pasku narzędzi Szybki dostęp należy wybrać polecenie
Zmień kształt (w starszych wersjach na pasku narzędzi Rysowanie należy kliknąć pole-
cenie Rysuj i wybrać pozycję Zmień autokształt). Wyświetlona zostanie lista opcji, wśród
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których będą Kształty podstawowe, Strzałki blokowe, Schemat blokowy, Gwiazdy i wstęgi oraz
Objaśnienia. Po wybraniu jednego z dostępnych kształtów wygląd pola komentarza zmieni
się odpowiednio do dokonanego wyboru, co widać na rysunku 2.11.

Rysunek 2.11. Niefortunnie sformatowany komentarz

Jeżeli użytkownik pracuje w Excelu 2007, może zauważyć, że dowolny wybrany przez
niego kształt będzie miał postać trójwymiarową. Aby uzyskać ten efekt we wcześniejszych
wersjach Excela, należy upewnić się, że komentarz cały czas jest zaznaczony, lecz nie
znajduje się w trybie edycji. Na pasku narzędzi Rysowanie trzeba kliknąć ikonę Ustawienia
cienia widoczną na rysunku 2.12 i wskazać cień odpowiedni dla komentarza.

Rysunek 2.12. Opcja Ustawienia cienia

Dodawanie rysunku
Kolejną ciekawą rzeczą, jaką można zrobić z komentarzem, jest wyświetlanie w nim obraz-
ków, które nie będą przeszkadzać w przeglądaniu danych. Można na przykład wstawić
w komentarzu obrazek wykresu, dzięki czemu dane zawarte w arkuszu będą lepiej zobra-
zowane, a sam wykres będzie widoczny tylko na żądanie.

Aby umieścić obrazek, należy upewnić się, że komentarz jest zaznaczony i nie znajduje
się w trybie edycji. Należy kliknąć na nim prawym przyciskiem myszy i wybrać Formatuj
komentarz… (użytkownicy wcześniejszych niż 2007 wersji Excela mogą również dwukrotnie
kliknąć na jego obramowaniu). W oknie dialogowym trzeba wybrać zakładkę Kolory i linie,
na liście Kolor: wybrać opcję Efekty wypełnienia i w oknie dialogowym Efekty wypełnienia
przejść na zakładkę Rysunek. Na zakładce tej wystarczy już tylko wskazać rysunek, który
ma znaleźć się w komentarzu.
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Wyodrębnianie tekstu komentarza
Jeszcze jedną rzeczą, jaką można zrobić z komentarzem, jest wyodrębnienie zapisanego
w nim tekstu i wyświetlenie go w komórce. W tym celu w module standardowym wystar-
czy umieścić prostą funkcję. Najpierw należy wybrać polecenie Deweloper→Kod→Visual Basic
(w starszych wersjach należy kliknąć polecenie Narzędzia→Makro→Edytor Visual Basic)
lub nacisnąć klawisze Alt/Option+F11, po czym wybrać polecenie Insert→Module i wpisać
poniższy kod:

Function GetCommentText(rCommentCell As Range)
Dim strGotIt As String
  On Error Resume Next
  strGotIt = WorksheetFunction.Clean(rCommentCell.Comment.Text)
  GetCommentText = strGotIt
  On Error GoTo 0
End Function

Aby powrócić do Excela, trzeba kliknąć przycisk Zamknij lub nacisnąć Alt/ +Q oraz zapisać
skoroszyt. Teraz wystarczy już w dowolnej komórce wpisać następującą formułę:

=GetCommentText(A1)

w której A1 jest komórką zawierającą komentarz. Tekst tego komentarza pojawi się w ko-
mórce, w której wpisano formułę.

S P O S Ó B

30.
<2007

Sortowanie względem więcej niż trzech kolumn
Narzędzie Sortuj dostępne w Excelu jest ograniczone, ponieważ pozwala ono na wskazanie jako kryterium
sortowania co najwyżej trzech pól. W większości przypadków to wystarczy, lecz czasami zachodzi potrzeba
posortowania danych według więcej niż trzech kolumn. Poniższy sposób pozwala obejść to ograniczenie.

W przykładzie tym przyjmiemy założenie, że powiązane ze sobą dane znajdują się
w kolumnach A, B, C, D i E; chcemy je posortować najpierw według kolumny A, potem
B, następnie C, potem D i na końcu według kolumny E. W tym celu musimy mieć jeszcze
możliwość sortowania odwrotnego, to znaczy najpierw posortowania danych według
ostatniego pola, a na końcu według pola pierwszego.

Najpierw należy zaznaczyć kolumny od A do E i wybrać polecenie Dane→Sortuj…. Następ-
nie trzeba ustalić porządek sortowania: najpierw posortowaniu powinna ulec kolumna
C, potem D i na końcu E. Wtedy należy kliknąć przycisk OK. Ponownie trzeba zaznaczyć
kolumny od A do E i wybrać Dane→Sortuj…, tym razem jednak sortowanie powinno się
odbyć względem kolumn A i B. Po kliknięciu OK wszystkie dane zostaną odpowiednio upo-
rządkowane — Excel posortuje je względem pięciu pól, a nie tylko zwyczajowych trzech.

Aby zautomatyzować to zadanie, można użyć makra, które posortuje zaznaczony obszar
i na podstawie formatowania w pierwszym wierszu zaznaczenia rozpozna, czy dane
posiadają nagłówki. Jeśli nagłówki będą zapisane czcionką pogrubioną, Excel będzie wie-
dział, że są to nagłówki kolumn, i nie uwzględni ich w trakcie sortowania. Samo sortowanie
zostanie wykonane, począwszy od kolumny znajdującej się najbardziej na lewo, a na kolum-
nie znajdującej się na prawo skończywszy, i będzie mogło zostać wykonane względem
nawet 256 kolumn.



SPOSÓB
31. Sortowanie losowe

88 | Sposoby na wbudowane mechanizmy Excela

Kod makra, którego należy użyć, powinien się znaleźć w module standardowym. Aby go
tam umieścić, należy wybrać polecenie Narzędzia→Makro→Edytor Visual Basic (Alt/Option+F11),
wybrać Insert→Module i wpisać poniższy kod:

Sub SortByX()
Dim l As Long

  For l = Selection.Columns.Count To 1 Step -1
    Selection.Sort Key1:=Selection.Cells(2, l), _
    Order1:=xlAscending, Header:=xlGuess, Orientation:=xlTopToBottom
  Next l
End Sub

Aby powrócić do Excela, trzeba zamknąć okno lub nacisnąć Alt/ +Q. Tym sposobem
będzie można wykonywać sortowania o wiele bardziej skomplikowane niż standardowo
dostępne w Excelu.

S P O S Ó B

31.
Wszystkie

Sortowanie losowe
W Excelu można wyznaczyć trzech „zwycięzców” — pierwszego, drugiego i trzeciego — wybranych w sposób
losowy z listy znajdującej się w arkuszu. Najłatwiejszym i najbardziej uczciwym sposobem na realizację tego
zadania jest użycie funkcji LOS oraz mechanizmów sortowania dostępnych w Excelu.

Załóżmy, że w arkuszu znajduje się tabela złożona z trzech kolumn, rozpoczynająca się
w kolumnie B i zawierająca pola Imię, Wiek i Numer w takiej właśnie kolejności. W komórce
A2 można wpisać funkcję LOS i skopiować ją do tylu wierszy, ile będzie trzeba — aż do
końca tabeli. Zaraz po wykonaniu kopiowania każda komórka w kolumnie A zawierająca
funkcję LOS zostanie automatycznie wypełniona liczbą losową, względem której można
posortować tabelę. Inaczej mówiąc, kolumny A, B, C i D można posortować względem
kolumny A w porządku rosnącym lub malejącym, a trzej zwycięzcy znajdą się w pierwszych
trzech wierszach tabeli.

Funkcja LOS jest funkcją zmienną, przeliczaną automatycznie po wykonaniu w Excelu
jakiejś czynności, na przykład po wpisaniu danych w innej komórce czy uruchomieniu
ponownego przeliczania arkusza klawiszem F9. Trzeba więc szybko zapisać zwycięzców.

Można jednak wykorzystać tę zmienność i zarejestrować makro, które wykona sortowanie
natychmiast po przeliczeniu arkusza i zwróceniu przez funkcję LOS kolejnego zestawu
liczb losowych. Makro to będzie można przypisać do przycisku, dzięki czemu za każdym
razem, gdy zajdzie potrzeba wybrania trzech zwycięzców, trzeba będzie jedynie kliknąć
przycisk i sprawdzić trzy imiona znajdujące się na samej górze tabeli.

Załóżmy na przykład, że dane znajdują się w kolumnach B, C i D oraz że pierwszy wiersz
zawiera nagłówki. Najpierw w komórce A1 należy wpisać nagłówek LOS. W komórce A2
trzeba wpisać =LOS() i skopiować ją w tylu wierszach, w ilu to konieczne, po czym zazna-
czyć dowolną komórkę i wybrać polecenie Deweloper→Kod→Zarejestruj makro (w starszych
wersjach jest to polecenie Narzędzia→Makro→Zarejestruj nowe makro…).

Należy zaznaczyć kolumny A, B, C i D i nacisnąć F9, aby uruchomić ponowne przeliczanie
(aby wymusić przeliczanie na komputerach Macintosh, należy nacisnąć +=), po czym
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wybrać polecenie Dane→Sortowanie i filtrowanie→Sortuj, a następnie przesortować dane
względem kolumny A. Po wykonaniu sortowania należy zatrzymać rejestrowanie makra.

W kolejnym kroku trzeba wybrać polecenie Deweloper→Formanty→Wstaw (w poprzed-
nich wersjach Widok→Paski narzędzi→Formularze), z paska narzędzi Formularze wybrać
przycisk i umieścić go w dowolnym miejscu arkusza. Przyciskowi temu trzeba przypisać
zarejestrowane przed chwilą makro, po czym kliknąć OK (w razie potrzeby można rów-
nież zmienić tekst przycisku z Przycisk 1 na inny, bardziej opisowy).

Kolumnę A można zaznaczyć i ją ukryć, ponieważ użytkownik nie musi widzieć wygene-
rowanych losowo liczb. Za każdym razem, gdy przycisk zostanie kliknięty, dane zostaną
posortowane losowo, a trzy imiona znajdujące się na samej górze będą imionami zwy-
cięzców, jak na rysunku 2.13.

Rysunek 2.13. Końcowy wynik sortowania losowego, w którym ukryto kolumnę A

W Excelu 2003 i 2007 funkcja LOS ma dosyć poważną wadę. Pomimo że
w Pomocy wyraźnie jest napisane, iż zwracane liczby losowe będą należeć
do przedziału od 0 do 1, nie zawsze warunek ten będzie spełniony, zwłaszcza
gdy funkcja LOS będzie używana w większej liczbie komórek. Czasami funkcja
może zwrócić wartość mniejszą od zera. Aby poznać powody, dla których
programiści z firmy Microsoft zdecydowali się zmienić jej algorytm, można
odwiedzić stronę http://support.microsoft.com/default.aspx?kbid=828795.

S P O S Ó B

32.
Wszystkie

Manipulowanie danymi przy użyciu Filtra zaawansowanego
Każdy użytkownik, który zna narzędzie Autofiltr, zna również jego ograniczenia. Jeśli konieczne jest
wykonanie bardziej złożonych operacji na danych, warto użyć narzędzia Filtr zaawansowany.

Pomimo swych ograniczeń Autofiltr nadaje się do wyświetlania danych, które spełniają
określone kryteria. Czasami jednak standardowe opcje dostępne w Autofiltrze nie wystar-
czają do tego, by znaleźć potrzebne informacje. Bardziej skomplikowane manipulowanie
danymi jest możliwe dzięki uniwersalnemu narzędziu Filtr zaawansowany.

Aby użyć Filtra zaawansowanego, najpierw trzeba umieścić dane w klasycznej tabeli, jak
opisano to w rozdziale 1.

Aby móc skorzystać z Filtra zaawansowanego, kopię nagłówków tabeli trzeba będzie umieścić
gdzieś powyżej samych danych. Nad tabelą danych zawsze powinno się zostawiać co naj-
mniej trzy puste wiersze. Aby zagwarantować sobie, że nagłówki pozostaną identyczne
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nawet w przypadku zmiany w nagłówkach tabeli, należy użyć odwołań do nagłówków
kolumn, wykorzystując zwykłą formułę odwołania, na przykład =A4, gdzie A4 jest komórką
nagłówka tabeli. Formułę tę należy skopiować do tylu kolumn, ile nagłówków znajduje się
w tabeli z danymi. Dzięki temu nagłówki kryteriów dla Filtra zaawansowanego będą miały
charakter dynamiczny. Bezpośrednio pod skopiowanymi nagłówkami należy wpisać kry-
teria, które zostaną użyte przez Filtr zaawansowany. Więcej informacji na ten temat można
znaleźć w Pomocy Excela pod hasłem Filtrowanie przy użyciu zaawansowanych kryteriów.

W trakcie pracy z Filtrem zaawansowanym należy pamiętać, że kryteria (dwa lub więcej) znaj-
dujące się bezpośrednio pod danym nagłówkiem są łączone instrukcją LUB. Jeśli powinny
one być uwzględniane jako koniunkcja, czyli filtrowane przy użyciu instrukcji ORAZ, nagłó-
wek kolumny i stosowane w niej kryteria muszą znajdować się obok siebie. Na rysunku
2.14 pokazano, jak należy filtrować dane przy użyciu operatora LUB, a na rysunku 2.15
zastosowano operator ORAZ.

Rysunek 2.14. Zastosowanie Filtra zaawansowanego z operatorem LUB w celu znalezienia osób,
które spłacają ratę w wysokości większej niż 16 zł LUB mniejszej niż 15 zł

Rysunek 2.15. Zastosowanie Filtra zaawansowanego z operatorem ORAZ w celu znalezienia osób,
których imiona zaczynają się na literę D ORAZ kończą się literą K

Obydwa powyższe przykłady ukazują stosunkowo proste zastosowania Filtra zaawanso-
wanego i mogą zostać wykonane również przy użyciu Autofiltra. Poniżej przedstawimy
takie przykłady zastosowania Filtra zaawansowanego, których nie można wykonać przy
użyciu Autofiltra.
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Załóżmy, że znaczna część imion w zakresie komórek $A$5:$A$500 się powtarza, a A4
jest komórką nagłówka. Ponadto przyjmijmy założenie, że niektóre nagłówki powtarzają
się po kilka razy. Zadanie polega na tym, by odczytać z listy wszystkie imiona, które wy-
stępują więcej niż jeden raz. Aby je wykonać, trzeba będzie użyć funkcji Filtr zaawan-
sowany, a kryterium zdefiniować za pomocą następującej formuły:

=LICZ.JEŻELI($A$5:$A$500;A5)>1

Po uruchomieniu Filtra zaawansowanego z opcją Kopiuj w inne miejsce nowo utworzona
lista będzie zawierała wszystkie te imiona, które na liście oryginalnej wystąpiły więcej
niż jeden raz (rysunek 2.16). Większość z tych imion powtórzy się kilkakrotnie, lecz można
je łatwo ponownie przefiltrować, używając Filtra zaawansowanego, tym razem z opcją Tylko
unikatowe rekordy (rysunek 2.17). W efekcie powstanie lista wszystkich imion, które poja-
wiają się więcej niż jeden raz.

Rysunek 2.16. Użycie Filtra zaawansowanego do znalezienia imion, które pojawiają się na liście
więcej niż jeden raz

Rysunek 2.17. Użycie Filtra zaawansowanego względem wyodrębnionej listy imion, aby każde imię
odczytać z niej tylko jeden raz (Tylko unikatowe rekordy)
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Należy zwrócić uwagę, że jeśli kryterium definiowane jest przy użyciu
formuły, nie można umieszczać nad nim nagłówka identycznego z nagłówkiem
z tabeli danych. Na przykład: jeżeli w kolumnie A znajduje się lista danych
liczbowych rozpoczynająca się w komórce A5 (a A4 jest komórką nagłówka)
i z listy tej trzeba odczytać wszystkie liczby większe od ich wartości średniej,
można by użyć kryterium zdefiniowanego jako:

=A5>ŚREDNIA($A$5:$A$500)

Gdyby kryterium to zostało umieszczone w komórce A2, zakresem kryteriów
byłby zakres $A$1:$A$2, lecz komórka $A$1 nie mogłaby zawierać takiego
samego nagłówka jak nagłówek znajdujący się na liście. Komórka ta musiałaby
pozostać pusta lub zawierać zupełnie inny nagłówek.

Trzeba również zaznaczyć, że każda użyta formuła powinna zwracać jedynie
wartości PRAWDA lub FAŁSZ. W funkcji ŚREDNIA zakres komórek został
wskazany jako odwołanie bezwzględne poprzez dodanie znaków dolara,
natomiast odwołanie do komórki A5 ma charakter względny. Zastosowanie
takiego rozwiązania jest konieczne, ponieważ w momencie użycia Filtra
zaawansowanego Excel zauważy, że A5 jest odwołaniem względnym i przejdzie
po kolei przez wszystkie pozycje na liście, zwracając dla każdej z nich wartość
PRAWDA lub FAŁSZ. Jeśli zwróconą wartością będzie PRAWDA, będzie
to oznaczało, że wartość z listy należy zostawić. Jeżeli natomiast zwróconą
wartością będzie FAŁSZ, pozycja na liście nie będzie spełniać kryteriów
i nie powinna być pokazywana.

Użytkownicy Filtra zaawansowanego często pytają, w jaki sposób mogą
przeprowadzić filtrowanie danych względem dokładnych podanych przez
siebie kryteriów. Jeśli kryterium jest Jan i wykonywane jest zaawansowane
filtrowanie na długiej liście imion, Excel oprócz imienia Jan wyświetli
również takie imiona jak Janek, Janusz, Jan K i tak dalej. Inaczej mówiąc,
każde imię rozpoczynające się od liter Jan zostanie potraktowane jako
pasujące do zadanego kryterium. Aby zmusić Excela, by wyszukał jedynie
pozycje dokładnie pasujące do kryterium, czyli w naszym przykładzie jedynie
imiona Jan, należy zdefiniować kryterium jako ="=Jan".

S P O S Ó B

33.
Wszystkie

Tworzenie własnych formatów liczbowych
Excel posiada własne, wbudowane formaty liczbowe, czasami jednak zachodzi konieczność użycia
formatu, którego Excel nie udostępnia. Wykorzystując sposoby przedstawione w tym punkcie, można
tworzyć formaty liczbowe dostosowane do własnych potrzeb.

Przed wykorzystaniem tych sposobów warto najpierw zrozumieć, w jaki sposób Excel
postrzega formaty komórek. Dla Excela każdy format komórki składa się z czterech czę-
ści (od strony lewej do prawej): Format liczb dodatnich, Format liczb ujemnych, Format zera,
Format tekstu. Każda z tych części jest oddzielona od sąsiednich znakiem średnika (;).

W tworzonym własnym formacie (formacie niestandardowym) nie trzeba definiować
wszystkich czterech części. Inaczej mówiąc, jeśli w formacie znajdą się tylko dwie części,
pierwsza z nich będzie stanowić format liczb dodatnich oraz zera, a druga będzie forma-
tem liczb ujemnych. Jeśli format będzie się składał tylko z jednej części, wszystkie liczby
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będą formatowane zgodnie z nią. Tekst jest formatowany tylko takim formatem niestan-
dardowym, który zawiera wszystkie cztery części — wówczas do tekstu odnosi się tylko
część ostatnia.

Nie należy przyjmować, że słowo liczbowy oznacza formaty niestandardowe
odnoszące się jedynie do danych liczbowych. Formaty liczbowe stosowane są
również względem tekstu.

Format niestandardowy przedstawiony na rysunku 2.18 zawiera definicję standardowe-
go formatu walutowego Excela, w którym ujemne wartości walutowe są wyświetlane na
czerwono. Format standardowy zmodyfikowaliśmy jednak poprzez dodanie oddzielnego
formatu dla wartości zerowej oraz jeszcze jednego formatu dla tekstu. Jeżeli jako wartość
walutową wpisze się liczbę dodatnią, Excel automatycznie sformatuje ją w taki sposób, by
separatorem tysięcy był znak spacji, a na końcu znajdowały się dwie cyfry dziesiętne. Tak
samo przedstawiane będą wartości ujemne, lecz znaki będą mieć kolor czerwony. Przy
wartości zerowej nie będzie symbolu waluty, będą za to dwie cyfry dziesiętne. Jeżeli na-
tomiast w komórce zostanie wpisany tekst, wówczas bez względu na jego postać Excel
wyświetli zdanie Bez tekstu proszę.

Rysunek 2.18. Części niestandardowego formatu liczbowego

Trzeba zaznaczyć, że sposób formatowania wartości znajdującej się w komórce nie ma
żadnego wpływu na tę wartość. Wpiszmy na przykład w komórce A1 dowolną liczbę,
kliknijmy prawym przyciskiem myszy i wybierzmy polecenie Formatuj komórki…→Liczby→
Niestandardowe i w miejsce dowolnie wybranego formatu wpiszmy słowo "Cześć" (wraz
ze znakami cudzysłowu), po czym kliknijmy przycisk OK.

Pomimo że w komórce wyświetlane jest słowo Cześć, rzeczywistą jej wartość można ujrzeć
na pasku formuły lub naciskając klawisz F2. Jeśli odwołamy się do tej komórki w formule,
na przykład =A1+20, w komórce wynikowej zastosowany zostanie format niestan-
dardowy. Jeśli odwołanie do komórki A1 będzie jednym z wielu odwołań, z których
pozostałe będą dotyczyć komórek sformatowanych standardowo — na przykład w for-
mule =SUMA(A1:A10) — w komórce wynikowej również zastosowany zostanie format
niestandardowy z komórki A1. Excel zakłada, że komórka wynikowa powinna być sforma-
towana tak samo jak komórki, do których następuje odwołanie. Jeżeli komórki, do których
odwołuje się formuła, zawierają więcej niż jeden rodzaj formatowania, pierwszeństwo
ma format niestandardowy.

Oznacza to, że zawsze trzeba pamiętać, iż do obliczeń Excel bierze prawdziwą wartość
komórek, a nie wartość wyświetlaną. Czasami daje to niespodziewane efekty, na przykład
wówczas, gdy Excel przeprowadza obliczenia na podstawie wartości komórek sformato-
wanych w taki sposób, by nie było w nich widać części dziesiętnych liczby lub wyświe-
tlanych było tylko kilka pierwszych cyfr po przecinku. Aby się o tym przekonać, można



SPOSÓB
33. Tworzenie własnych formatów liczbowych

94 | Sposoby na wbudowane mechanizmy Excela

wpisać w komórce A1 wartość 1,4, w komórce A2 również liczbę 1,4, sformatować obie
komórki tak, by nie było w nich widać części dziesiętnych i w innej komórce wpisać =A1+A2.
Wynikiem będzie oczywiście liczba 3, ponieważ Excel zaokrągli otrzymaną sumę.

W Excelu znajduje się opcja Dokładność jak wyświetlono, którą można znaleźć,
wybierając polecenie Przycisk Office→Opcje programu Excel→Zaawansowane
(w starszych wersjach Narzędzia→Opcje…→Przeliczanie). Trzeba jednak pamiętać,
że zaznaczenie tej opcji spowoduje trwałą zmianę dokładności wartości
przechowywanych w komórkach z 15 liczb na taką dokładność, jaka wynika
z liczby cyfr po przecinku wyświetlanych przez dany format. Inaczej mówiąc,
po zaznaczeniu tej opcji i kliknięciu OK nie będzie można powrócić do zwykłej
dokładności (można usunąć zaznaczenie tej opcji, lecz usunięte wcześniej
cyfry po przecinku nie zostaną przywrócone).

Domyślnym formatem każdej komórki jest format Ogólne. Jeżeli w komórce wpisze się
liczbę, Excel zazwyczaj odgadnie format najbardziej dla niej odpowiedni. Jeśli na przy-
kład w komórce zostanie wpisana wartość 10%, Excel sformatuje ją formatem Procentowe.
W większości przypadków odgadnięty format okaże się prawidłowy, czasami jednak trzeba
będzie go zmienić.

Korzystając z polecenia Formatuj komórki…, należy wystrzegać się wskazywania
wyrównywania poziomego do strony lewej, prawej lub do środka! Domyślnie
liczby są wyrównywane do prawej, a tekst do lewej strony. Jeśli ustawień tych
się nie zmieni, na pierwszy rzut oka będzie można stwierdzić, czy komórka
zawiera tekst czy też liczbę — tak jak we wcześniejszym przykładzie, w którym
komórka A1 wyglądała, jakby zawierała tekst, a w rzeczywistości znajdowała
się w niej liczba.

W każdej części formatu znajduje się odpowiedni dla niej zbiór kodów formatujących.
Na podstawie tych kodów Excel wyświetla dane w sposób zgodny z wolą użytkownika.
Zatem załóżmy, że liczby ujemne powinny być wyświetlane w nawiasach i wszystkie
liczby — dodatnie, ujemne i zero — powinny posiadać dwie cyfry po przecinku. W tym
celu musimy użyć formatu niestandardowego:

0,00_ ;(-0,00)

Jeżeli liczby ujemne mają dodatkowo być prezentowane na czerwono, trzeba użyć po-
niższego formatu niestandardowego:

0,00_ ;[Czerwony](-0,00)

Zwróćmy uwagę na znajdujące się w tym formacie nawiasy kwadratowe. Taki kod for-
matujący informuje Excela, że liczba powinna mieć kolor czerwony.

W każdej z części formatu niestandardowego można użyć wielu różnych kodów formatują-
cych. Poszczególne kody zostały opisane w tabelach 2.1 — 2.5 na podstawie dokumentacji
firmy Microsoft. Tabela 2.1 zawiera kody formatujące, tabela 2.2 kody tekstowe, tabela 2.3
obejmuje kody dat, w tabeli 2.4 znajdują się kody czasu, a w tabeli 2.5 zawarte są różne
inne kody.
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Tabela 2.1. Kody formatujące

Kod liczbowy Opis

Ogólne Ogólny format liczbowy.

0 (zero) Symbol powodujący wyświetlenie zer niemających znaczenia, jeśli liczba
posiada mniej cyfr niż jest zer w formacie.

# Symbol powodujący wyświetlenie cyfr znaczących bez zer niemających
znaczenia.

? Symbol powodujący pozostawienie miejsca dla zer niemających
znaczenia, które nie są jednak wyświetlane.

% Format procentowy. Excel mnoży wartość przez 100 i za liczbą wyświetla
znak %.

(spacja) Separator tysięcy. Znak spacji i występujący po nim symbol wyznacza
formatowanie tysięcy.

E+ E- e+ e- Zapis naukowy.

Tabela 2.2. Kody tekstowe

Kod tekstowy Opis

$ - + / () :
spacja

Wymienione znaki są wyświetlane w liczbie. Aby wyświetlić jakikolwiek
inny znak, trzeba wpisać go w cudzysłowach lub poprzedzić lewym
ukośnikiem.

\znak Kod ten powoduje wyświetlenie wskazanego znaku. Jeśli wpisany
zostanie któryś spośród następujących znaków: !, ^, &, ', ~, {, }, =, <
lub >, automatycznie zostanie on poprzedzony lewym ukośnikiem.

"tekst" Kod ten powoduje wyświetlenie tekstu znajdującego się między
cudzysłowami.

* Kod ten powoduje wypełnienie szerokości następującym po nim znakiem.
W jednej części formatu może znajdować się jedynie jeden symbol gwiazdki.

_ (podkreślenie) Kod ten powoduje pozostawienie wolnego miejsca o szerokości równiej
szerokości następnego znaku. Często stosuje się go w kombinacji _),
aby pozostawić miejsce dla nawiasu zamykającego w formacie liczby
dodatniej, gdy format liczby ujemnej uwzględnia występowanie nawiasów.
Dzięki temu separator części dziesiętnej zarówno w wartościach dodatnich,
jak i ujemnych znajduje się w tym samym miejscu.

@ Obszar zablokowany dla tekstu.

Zwróćmy uwagę zwłaszcza na ostatni rodzaj kodów formatujących, przedstawiony w ta-
beli 2.5: operatory porównania. Załóżmy, że nasz format niestandardowy w postaci
0,00_ ;[Czerwony](-0,00) ma wyświetlać liczby ujemne na czerwono i w nawiasach
tylko wtedy, gdy liczba jest mniejsza od –100. W tym celu format ten trzeba zapisać jako:

0,00_ ;[Czerwony][<-100](-0,00);0,00

Pożądany efekt zostanie osiągnięty za sprawą kodów formatujących [Czerwony]
[<-100](-0,00), wpisanych w części dotyczącej liczb ujemnych. Używając tego rozwią-
zania w połączeniu z formatowaniem warunkowym, można podwoić liczbę warunków
w formacie warunkowym z trzech do sześciu.
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Tabela 2.3. Kody dat

Kod daty Opis

M Miesiąc wyświetlany jako liczba bez zera poprzedzającego (1 – 12).
Mm Miesiąc wyświetlany jako liczba z zerem poprzedzającym (01 – 12).
Mmm Skrót nazwy miesiąca (Sty – Gru).
Mmmm Pełna nazwa miesiąca (Styczeń – Grudzień).
D Dzień wyświetlany jako liczba bez zera poprzedzającego (1 – 31).
Dd Dzień wyświetlany jako liczba z zerem poprzedzającym (01 – 31).
Ddd Skrót nazwy dnia tygodnia (Pon – Nie).
Dddd Pełna nazwa dnia tygodnia (Poniedziałek – Niedziela).
Rr Rok wyświetlany jako liczba dwucyfrowa (na przykład 96).
Rrrr Rok wyświetlany jako liczba czterocyfrowa (na przykład 1996).

Tabela 2.4. Kody czasu

Kod czasu Opis

G Godziny wyświetlane jako liczba bez zera poprzedzającego (0 – 23).
Gg Godziny wyświetlane jako liczba z zerem poprzedzającym (00 – 23).
m Minuty wyświetlane jako liczba bez zera poprzedzającego (0 – 59).
mm Minuty wyświetlane jako liczba z zerem poprzedzającym (00 – 59).
s Sekundy wyświetlane jako liczba bez zera poprzedzającego (0 – 59).
ss Sekundy wyświetlane jako liczba z zerem poprzedzającym (00 – 59).
AM/PM am/pm Godzina dnia wyświetlana w formacie zegara 12-godzinnego.

Tabela 2.5. Inne kody

Inny kod Opis

[CZARNY],
[NIEBIESKI],
[BŁĘKITNY],
[ZIELONY],
[PURPUROWY],
[CZERWONY],
[BIAŁY],
[ŻÓŁTY],
[KOLOR n]

Kody te powodują wyświetlenie znaków we wskazanym kolorze. Symbol
n może mieć wartości od 1 do 56 i odnosi się do n-tego koloru na palecie
kolorów.

[Warunek
wartość]

Warunek może mieć postać <, >, =, >=, <= lub <>, natomiast wartość
może być dowolną liczbą. Format liczbowy może zawierać najwyżej dwa
warunki.

Często użytkownicy chcą, by symbole walutowe były wypisywane słownie. W tym celu
należy użyć następującego formatu niestandardowego:

0 "złotych i " ,00 "groszy"
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Dzięki temu formatowi liczba postaci 55,25 zostanie wyświetlona jako 55 złotych i 25
groszy. Jeśli liczby mają być przekształcane na wartości słowne, można oprzeć się na
dwóch funkcjach opublikowanych przez Microsoft, opisanych na stronach http://www.ozgrid.

com/VBA/ValueToWords.htm oraz http://www.ozgrid.com/VBA/CurrencyToWords.htm.

Dzięki formatowi niestandardowemu można również wyświetlać wraz z wpisaną liczbą
słowa Niska, Średnia lub Wysoka. Wystarczy zastosować następujący format:

[<11]"Niska"* 0;[>20]"Wysoka"* 0;"Średnia"* 0

Zwróćmy uwagę na znak *. Dzięki niemu następujący po tym symbolu znak zostanie użyty
do wypełnienia całej szerokości kolumny. W efekcie słowa Niska, Średnia i Wysoka
będą wyrównane do prawej strony, a liczby będą wyrównane do strony lewej.

S P O S Ó B

34.
<2007

Zwiększanie liczby możliwych operacji Cofnij
w Excelu dla Windowsa
Chyba wszyscy użytkownicy Excela znają polecenie Cofnij dostępne w Excelu, które pozwala na cofnięcie
popełnionych błędów. Niestety, domyślnie można cofnąć zaledwie 16 ostatnich operacji. Sposób opisany
w tym punkcie będzie polegał na zmianie wpisu w rejestrze, dzięki czemu będzie można cofnąć nawet
100 ostatnich operacji.

Gdy wycofując wykonane czynności, użytkownik cofnie 16. operację, wówczas pierwsze
wycofanie zostanie zastąpione przez 17. i tak dalej. Co więcej, gdy tylko skoroszyt zostanie
zapisany, wyczyszczeniu ulegnie stos operacji Cofnij i historia wykonanych czynności
zostanie utracona. Wynika to z faktu, że naciśnięcie przycisku Zapisz jest dla Excela
równoznaczne z tym, że użytkownik nie ma zastrzeżeń do wykonanych przez siebie czyn-
ności, zatem ich historia nie jest już do niczego potrzebna.

Od czasu do czasu może się okazać, że pojemność stosu operacji Cofnij, pozwalająca na
przechowywanie zaledwie 16 ostatnich czynności, jest niewystarczająca. Nie trzeba jednak
przechodzić nad tym do porządku dziennego, lecz można to zmienić, przeprowadzając
edycję rejestru — czegoś, co działa tylko w systemie Windows. W tym celu należy najpierw
zamknąć Excela, wybrać polecenie Start→Uruchom… i w polu Otwórz wpisać Regedit.exe,
po czym kliknąć OK. Gdy Edytor rejestru zostanie już uruchomiony, trzeba rozwinąć folder
HKEY_CURRENT_USER, następnie znajdujący się w nim folder Software, potem Microsoft,
Office i 11.0 (nazwa tego ostatniego będzie zależeć od wersji — 11.0 to wersja Excela 2003),
po czym trzeba rozwinąć folder Excel i w końcu otworzyć folder Options.

W Edytorze rejestru trzeba wybrać polecenie Edycja→Nowy→Wartość DWORD, wpisać
słowo UndoHistory i nacisnąć klawisz Enter. Utworzoną wartość UndoHistory należy
kliknąć dwukrotnie myszą i wpisać w niej liczbę większą od 16 i mniejszą od 100.

Pozostaje mieć nadzieję, że możliwość cofnięcia 100 ostatnich operacji wystarczy nawet
najbardziej wymagającym użytkownikom. Nie zmienia to jednak faktu, że zapisanie sko-
roszytu nadal będzie prowadzić do wyczyszczenia historii wykonanych czynności.
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S P O S Ó B

35.
Wszystkie

Tworzenie własnych list
Po dodaniu do Excela własnej listy można wpisać w arkuszu jej pierwszą pozycję, przeciągnąć ją w dół za
pomocą uchwytu wypełniania i patrzeć, jak lista wypełnia się automatycznie.

Jedną z najczęściej wykorzystywanych możliwości Excela, pozwalającą na oszczędzenie
znacznej ilości czasu, jest możliwość automatycznego zwiększania nie tylko liczb, ale
również niektórych rodzajów wartości tekstowych. Excel udostępnia kilka list wbudowa-
nych, takich jak dni tygodnia czy miesiące roku. Aby skorzystać z uchwytu wypełniania,
trzeba najpierw wpisać pierwszą pozycję z listy, a potem za pomocą uchwytu wypeł-
niania uzupełnić kolejne komórki następnymi pozycjami z listy. Bez trudu można również
tworzyć własne listy najczęściej używanych elementów.

Najbardziej elastyczny sposób tworzenia własnej listy polega na wpisaniu jej zawartości
w zakresie komórek. Powiedzmy na przykład, że mamy listę 100 pracowników. Najpierw
trzeba wpisać nazwisko każdego z nich, rozpoczynając w komórce A1 i na A100 kończąc,
po czym w razie konieczności posortować tę listę. Następnie trzeba wybrać polecenie
Przycisk Office→Opcje programu Excel→Popularne→Edytuj listy niestandardowe… (we wcze-
śniejszych wersjach należy wybrać polecenie Narzędzia→Opcje… i na zakładce Listy nie-
standardowe kliknąć myszą w polu Importuj listę z komórek), po czym kliknąć lewym przyci-
skiem myszy na komórce A1 i przeciągnąć nią aż do komórki A100, a na koniec kliknąć
przycisk Importuj. Od tej chwili zdefiniowana lista będzie na tym komputerze dostępna
we wszystkich skoroszytach.

Po utworzeniu własnej listy można ją odwrócić. W tym celu należy w pierwszej komórce
kolumny, sąsiadującej z kolumną zawierającą listę, wpisać ostatnią pozycję z tej listy,
w komórce następnej wpisać przedostatnią pozycję z listy, a następnie zaznaczyć obie
komórki i kliknąć dwukrotnie na uchwycie wypełniania. Spowoduje to odwrócenie utwo-
rzonej listy. Listę oryginalną można posortować, przechodząc na kartę Dane i wybierając
polecenie Sortowanie i filtrowanie→Sortuj (w starszych wersjach wybiera się polecenie
Dane→Sortuj…→ Opcje…).

Jeśli utworzona lista została już posortowana od A do Z i trzeba odwrócić
kolejność występujących w niej elementów, łatwiejsze może okazać się jej
posortowanie od Z do A.

S P O S Ó B

36.
Wszystkie

Pogrubianie znaków sum pośrednich Excela
Czyż nie byłoby wspaniale, gdyby sumy pośrednie znajdujące się w arkuszu były oznaczane tak, że ich
znalezienie nie sprawiałoby żadnej trudności? Niniejszy sposób umożliwia osiągnięcie takiego efektu.

Gdy w używanym arkuszu znajdują się sumy pośrednie utworzone poleceniem Dane→
Sumy częściowe…, ich wartości mogą być trudno identyfikowalne, a sam arkusz niezbyt
czytelny. Dotyczy to zwłaszcza przypadków, gdy sumy pośrednie są wyznaczane w tabe-
lach ze znaczną liczbą kolumn.

Zazwyczaj obliczone sumy pośrednie wyświetlane są z prawej strony, a powiązane z nimi
nagłówki znajdują się w pierwszej kolumnie. Wartości sum pośrednich nie są pogrubiane,
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dlatego ich powiązanie z nagłówkami wierszy może sprawiać trudności. Można jednak
sprawić, by wartości sum pośrednich były o wiele bardziej czytelne dzięki ich pogrubieniu.

Aby rozpoznać istotę problemu, wpiszmy dane tak, jak pokazano na rysunku 2.19.

Rysunek 2.19. Arkusz z danymi przed dodaniem sum pośrednich

Następnie dodajmy sumy pośrednie za pomocą polecenia Dane→Konspekt→Suma czę-
ściowa (w starszych wersjach służy do tego polecenia Dane→Sumy częściowe…), akcep-
tując domyślne wartości w oknie dialogowym Sumy pośrednie i klikając przycisk OK.

Na rysunku 2.20 widać, że nagłówki sum pośrednich zostały pogrubione, lecz same wartości
sum już nie. Jako że tabela ta składa się tylko z dwóch kolumn, odnalezienie i odczytanie
wartości sum pośrednich nie jest jeszcze wielkim problemem.

Rysunek 2.20. Arkusz z danymi po wstawieniu sum pośrednich

Jednak im więcej kolumn posiada tabela, tym trudniej odczytać z niej sumy pośrednie.
Problem ten można rozwiązać, korzystając z formatowania warunkowego. Pozostańmy
przy przykładzie z rysunku 2.19 i wypróbujmy ten sposób przed zastosowaniem sum
pośrednich. Najpierw należy zatem zaznaczyć zakres A1:B9 w ten sposób, by A1 była
aktywną komórką zaznaczenia, następnie trzeba wybrać polecenie Narzędzia główne→Style
→Formatowanie warunkowe→Nowa reguła…→Użyj formuły do określenia komórek, które należy
sformatować (w poprzednich wersjach trzeba wybrać polecenie Format→Formatowanie wa-
runkowe…, wskazać opcję Formuła jest) i wpisać następującą formułę:

=PRAWY($A1;4)="Suma"
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Następnie należy kliknąć przycisk Formatuj… i na zakładce Czcionka jako Styl czcionki
zaznaczyć styl Pogrubiony.

Ważnym elementem przedstawionej formuły jest zastosowanie w niej bezwzględnego
odwołania do kolumny ($A) i odwołania względnego do wiersza (1). Gdy zaznaczanie
rozpocznie się od komórki A1, Excel w każdej kolejnej komórce automatycznie zmieni
treść formuły. Na przykład w komórkach A2 i B2 formuła formatowania warunkowego
będzie miała postać =PRAWY($A2;4)="Suma", a w komórkach A3 i B3 formuła ta będzie
zdefiniowana jako =PRAWY($A3;4)="Suma".

Po wstawieniu sum pośrednich dane będą wyglądać podobnie jak na rysunku 2.21.

Rysunek 2.21. Arkusz z danymi po sformatowaniu sum pośrednich

Trzeba jeszcze pamiętać, że jeśli sumy pośrednie zostaną usunięte, czcionka pogrubiona
w ogóle nie zostanie zastosowana.

Sposób na sposób
Jedyną wadą tego rozwiązania jest fakt, że Suma końcowa jest formatowana tym samym
stylem, co wartości dla poszczególnych kwartałów. Dobrze by było sformatować sumę
końcową w inny sposób, by odróżniała się ona od sum pośrednich oraz wartości dla
poszczególnych kwartałów i była wyraźnie widoczna. Wykonajmy to zadanie na tym
samym przykładzie.

Należy usunąć poprzednie formatowanie warunkowe, wybierając polecenie Formatowa-
nie warunkowe→Zarządzaj regułami…, zaznaczając regułę i klikając przycisk Usuń regułę
(w starszych wersjach należy kliknąć polecenie Format→Formatowanie warunkowe→Usuń).

Rozpoczynając od arkusza z danymi w oryginalnej postaci, należy zaznaczyć zakres komó-
rek A1:B9, upewniając się, że A1 będzie komórką aktywną, wybrać Formatowanie warun-
kowe→Zarządzaj regułami…→Nowa reguła…→Użyj formuły do określenia komórek, które należy
sformatować (w poprzednich wersjach należy wybrać polecenie Format→Formatowanie warun-
kowe… i wskazać opcję Formuła jest). W polu Formatuj wartości, dla których następująca formuła
jest prawdziwa trzeba wpisać następującą jej definicję:

=$A1="Suma końcowa"



Przekształcanie formuł i funkcji Excela w wartości
SPOSÓB
37.

Sposoby na wbudowane mechanizmy Excela | 101

Następnie należy kliknąć przycisk Formatuj… i na zakładce Czcionka ustawić Styl czcionki
jako Pogrubiony. Po kliknięciu OK i Dodaj trzeba kliknąć przycisk Nowa reguła… (wcześniej
Dodaj), aby dodać drugi warunek formatowania. Należy wskazać opcję Formatuj tylko
komórki zawierające (poprzednio Formuła jest) i wpisać następującą formułę:

=PRAWY($A1;4)="Suma"

Następnie należy kliknąć przycisk Formatuj… i na zakładce Czcionka ustawić Styl czcionki
jako Pogrubiona kursywa. W polu Podkreślenie należy natomiast wybrać opcję Pojedyncze,
po czym kliknąć przycisk OK i ponownie OK.

W przypadku Excela 2007 reguły dodawane są do formatowania warunkowego
w ten sposób, że reguła stworzona jako pierwsza znajduje się na końcu listy,
reguła utworzona jako druga znajduje się nad pierwszą i tak dalej. Oznacza
to, że reguła utworzona jako ostatnia zostanie zastosowana jako pierwsza (w
wersjach wcześniejszych było na odwrót). W przypadku tego sposobu należy
zmienić kolejność zastosowanych reguł. W tym celu należy kliknąć pierwszą
z utworzonych reguł (=$A1="Suma końcowa") i kliknąć przycisk Przenieś w górę.

Na koniec trzeba wybrać polecenie Suma częściowa znajdujące się w grupie Konspekt na karcie
Dane (w poprzednich wersjach jest to polecenie Dane→Sumy częściowe…), zaakceptować
wartości domyślne i kliknąć OK.

Arkusz z danymi powinien wyglądać podobnie jak na rysunku 2.22.

Rysunek 2.22. Arkusz z danymi z lepiej wyróżnioną sumą całkowitą

Aby zwiększyć czytelność sum pośrednich, można zastosować dowolny format wybrany
przez użytkownika.

S P O S Ó B

37.
Wszystkie

Przekształcanie formuł i funkcji Excela w wartości
Większość arkuszy Excela zawiera formuły. Czasami pożądane jest, by w komórce znajdował się jedynie
wynik formuły, a nie sama formuła, której wartość zmieni się za każdym razem, gdy (jeśli) zmianie ulegną
dane, do których się odwołuje.

Cel ten można osiągnąć ręcznie kilkoma sposobami lub użyć makra, które szybko upora
się z zadaniem. Poznajmy najpierw metody ręczne.
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Wklej specjalnie
Dzięki poleceniu Wklej specjalnie… można skopiować wynik formuły, samą formułę pozo-
stawiając cały czas w tym samym miejscu. Załóżmy, że formuły znajdują się w komórkach
A1:A100. Należy zaznaczyć ten zakres, wybrać polecenie Kopiuj i zaznaczyć pierwszą
komórkę zakresu, w którym mają się znaleźć same wyniki formuł. Następnie trzeba wybrać
polecenie Schowek→Wklej→ Wartości (lub kliknąć prawym przyciskiem myszy i wybrać
polecenie Wklej specjalnie…→Wartości) i kliknąć przycisk OK.

Jeśli w miejscu oryginalnych formuł powinny znaleźć się jedynie ich wyniki, trzeba zazna-
czyć komórki zawierające formuły i wybrać polecenie Kopiuj, a następnie, nie usuwając
zaznaczenia, wybrać polecenie Wklej→Wklej wartości (lub kliknąć prawym przyciskiem
myszy i wybrać polecenie Wklej specjalnie…→Wartości) i kliknąć przycisk OK.

Kopiuj tutaj tylko wartości
Wyniki formuł można kopiować bez usuwania samych formuł również przy użyciu menu
podręcznego, o którego istnieniu większość użytkowników nawet nie wie.

Najpierw trzeba zaznaczyć zakres komórek i kliknąć prawym przyciskiem myszy na prawej
lub lewej krawędzi zaznaczenia (inaczej mówiąc, można kliknąć w dowolnym miejscu
zaznaczenia oprócz uchwytu wypełniania). Trzymając wciśnięty prawy przycisk myszy
(a na komputerach Macintosh trzymając naciśnięty klawisz Ctrl), należy przenieść zazna-
czony zakres do miejsca docelowego, zwolnić prawy przycisk myszy i w wyświetlonym
menu podręcznym wybrać pozycję Kopiuj tutaj tylko wartości.

Oryginalne formuły można również zastąpić ich wynikami. W tym celu należy zaznaczyć
zakres komórek formuł i kliknąć prawym przyciskiem myszy na prawej lub lewej krawędzi
zaznaczenia (czyli tak jak poprzednio: gdziekolwiek na zaznaczeniu, tylko nie na uchwycie
wypełniania). Trzymając wciśnięty prawy przycisk (lub naciskając klawisz Ctrl), trzeba
przeciągnąć zaznaczenie jedną kolumnę w prawo lub w lewo, umieścić je z powrotem
w początkowym położeniu, zwolnić prawy przycisk myszy i w menu podręcznym wybrać
polecenie Kopiuj tutaj tylko wartości, co przedstawiono na rysunku 2.23.

Makro
Jeśli zastępowanie formuł i funkcji znajdujących się w komórkach ich wynikami przepro-
wadzane jest stosunkowo często, można użyć poniższego prostego makra:

Sub ValuesOnly()
Dim rRange As Range
  On Error Resume Next
    Set rRange = Application.InputBox(Prompt:="Zaznacz formuły", _
               Title:="TYLKO WARTOŚCI", Type:=8)
    If rRange Is Nothing Then Exit Sub
  rRange = rRange.Value
End Sub
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Rysunek 2.23. Menu podręczne

Aby uruchomić makro, należy najpierw wybrać polecenie Deweloper→Kod→Visual Basic
(w starszych wersjach Narzędzia→Makro→Edytor Visual Basic) lub nacisnąć klawisze
Alt/Option+F11. W samym edytorze trzeba wstawić moduł, wybierając polecenie Insert→
Module, po czym w oknie modułu wpisać powyższe makro. Po jego wpisaniu należy
zamknąć okno za pomocą przycisku Zamknij lub kombinacji klawiszy Alt/ +Q i powrócić
do Excela. Następnie trzeba wybrać polecenie Deweloper→Kod→Makra (w poprzednich
wersjach Narzędzia→Makro→Makra…) lub nacisnąć klawisze Alt/Option+F8, zaznaczyć
makro ValuesOnly i kliknąć przycisk Opcje…, aby przypisać makru klawisz skrótu. Gdy
zostanie ono uruchomione, na ekranie zostanie wyświetlone okno InputBox z prośbą
o zaznaczenie zakresu komórek zawierających formuły. Adres zaznaczonego zakresu
automatycznie pojawi się w oknie dialogowym, a użytkownikowi pozostanie już tylko
kliknięcie przycisku OK.

S P O S Ó B

38.
Wszystkie

Automatyczne dodawanie danych
do list sprawdzania poprawności danych
Mechanizm sprawdzania poprawności danych doskonale spełnia swoją rolę, lecz istnieje jedna ważna
rzecz, której (bez niniejszego sposobu) nie można wykonać: mianowicie nie można automatycznie
dodawać nowych pozycji do listy stanowiącej źródło listy sprawdzania poprawności danych. Poniższy
sposób umożliwia użytkownikom dodanie do listy nowych pozycji poprzez pokazanie okna dialogowego
z opcją dodania lub anulowania. Duplikaty będą ignorowane.

Każdy użytkownik, który korzystał ze sprawdzania poprawności danych, wie, że jest to
bardzo użyteczne narzędzie. Chyba największe wrażenie robi możliwość dodania do
dowolnej komórki listy, z której wybierać może użytkownik. A czyż nie byłoby jeszcze
ciekawiej, gdyby istniała możliwość wpisania w sprawdzanej komórce nowej pozycji, którą
Excel automatycznie dodałby do listy? Otóż dzięki temu sposobowi taka możliwość istnieje.
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Załóżmy, że w komórkach A1:A10 znajduje się lista nazwisk widoczna na rysunku 2.24.

Rysunek 2.24. Skoroszyt przygotowany do używania w nim listy sprawdzania poprawności

Są to nazwiska pracowników firmy. Dodawanie do takiej listy nowych pracowników nie
jest rzadkością, lecz na razie jedynym sposobem wykonania tego zadania jest dopisanie
nowego nazwiska do listy, a dopiero potem wybranie go z listy wyświetlonej w spraw-
dzanej komórce.

Aby ominąć to ograniczenie, należy wykonać następujące czynności: najpierw w komórce A11
trzeba wpisać poniższą formułę, a następnie skopiować ją do wiersza numer 20, jak przed-
stawiono to na rysunku 2.25 (zwróćmy uwagę na względne odwołanie do komórki A10):

=JEŻELI(LUB($D$1="";LICZ.JEŻELI($A$1:A10;$D$1));"x";$D$1)

Rysunek 2.25. Lista z formułami dodanymi w komórkach A11:A20

Teraz trzeba wybrać polecenie Formuły→Nazwy zdefiniowane→Definiuj nazwę (w starszych
wersjach należy wybrać polecenie Wstaw→Nazwa→Definiuj…) i w polu Nazwa (Nazwy
w skoroszycie:) wpisać Nazwiska. W polu Odwołuje się do: należy wpisać poniższą formułę,
jak pokazano na rysunku 2.26, po czym kliknąć przycisk Dodaj, a następnie przycisk OK:

=PRZESUNIĘCIE(Arkusz1!$A$1;0;0;ILE.NIEPUSTYCH(Arkusz1!$A:$A);1)



Automatyczne dodawanie danych do list sprawdzania poprawności danych
SPOSÓB
38.

Sposoby na wbudowane mechanizmy Excela | 105

Rysunek 2.26. Tworzenie dynamicznej listy

W kolejnym kroku trzeba zaznaczyć komórkę D1 i wybrać polecenie Dane→Narzędzia
danych→Poprawność danych (wcześniej Dane→Sprawdzanie poprawności…), w polu Dozwo-
lone: wskazać pozycję Lista, a w polu Źródło: wpisać =Nazwiska, upewniając się jednocześnie,
że zaznaczone jest pole wyboru Rozwinięcia w komórce. Na zakładce Alert o błędzie trzeba
usunąć zaznaczenie pola wyboru Pokazuj alerty po wprowadzeniu nieprawidłowych danych
i kliknąć przycisk OK. Efekt będzie taki sam, jak na rysunku 2.27.

Rysunek 2.27. Lista sprawdzania poprawności po dodaniu jej do komórki D1

Następnie należy kliknąć prawym przyciskiem myszy na zakładce nazwy arkusza i wybrać
pozycję Wyświetl kod, po czym wpisać następujący kod:

Private Sub Worksheet_Change(ByVal Target As Range)
Dim lReply As Long
  If Target.Cells.Count > 1 Then Exit Sub

    If Target.Address = "$D$1" Then
      If IsEmpty(Target) Then Exit Sub
      If WorksheetFunction.CountIf(Range("Nazwiska"), Target) = 0 Then
        lReply = MsgBox("Dodaj " & Target & " do listy", vbYesNo + vbQuestion)
        If lReply = vbYes Then
          Range("Nazwiska").Cells(Range("Nazwiska").Rows.Count + 1, 1) = Target
        End If
      End If
  End If
End Sub
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Okno trzeba następnie zamknąć, aby zapisać skoroszyt i powrócić do Excela. Potem należy
zaznaczyć komórkę D1, wpisać w niej dowolne nazwisko, które nie znajduje się na liście,
i nacisnąć Enter. Po ponownym zaznaczeniu komórki D1 można przejrzeć listę; powinno
się na niej znajdować nowe nazwisko, jak na rysunku 2.28.

Rysunek 2.28. Lista po dodaniu do niej nowego nazwiska wpisanego w komórce D1

Aby do listy dopisać więcej niż 10 nazwisk, wystarczy skopiować formułę do kolejnych
wierszy poniżej wiersza 20.

S P O S Ó B

39.
Wszystkie

Sposoby na datę i godzinę w Excelu
Mechanizmy Excela związane z datami i godzinami doskonale sprawdzają się w niezbyt skomplikowanych
arkuszach, ale w projektach bardziej zaawansowanych mogą być przyczyną problemów. Na szczęście
istnieją sposoby, dzięki którym można zneutralizować te założenia Excela, które stoją w sprzeczności
z potrzebami użytkownika.

W Excelu domyślnie używany jest system daty 1900. Oznacza to, że data 1 stycznia 1900
ma wartość liczbową równą 1, 2 stycznia 1900 to wartość 2 i tak dalej. Wartości te stanowią
w Excelu tak zwane wartości porządkowe, dzięki którym daty mogą być używane w trakcie
obliczeń.

Podobnie rzecz przedstawia się z godzinami — tyle tylko, że Excel traktuje godziny jako
ułamki dziesiętne, przy czym 1 oznacza godzinę 24:00 lub 00:00, a na przykład godzinie
18:00 odpowiada wartość 0,75, ponieważ godzina ta stanowi trzy czwarte z 24 godzin.

Aby sprawdzić liczbową wartość daty i (lub) godziny, należy w komórce zawierającej
datę ustawić format Ogólne. Na przykład data i godzina 3 maja 2007 15:00:00 ma wartość
liczbową równą 39 205,625, w której część ułamkowa reprezentuje godzinę, a 39205 jest
wartością porządkową daty 3 maja 2007.

Dodawanie więcej niż 24 godzin
Godziny można dodawać do siebie przy użyciu funkcji SUMA (lub zwykłego znaku plusa).
Zatem jeśli tylko komórki A1:A5 zawierają prawidłowe godziny, to wartością formuły
=SUMA(A1:A5) będzie całkowita suma godzin. Jest jednak jedno poważne „ale”: jeśli nie
zostanie powiedziane inaczej, Excel nie doda do siebie więcej niż 24 godzin. Przyczyną



Sposoby na datę i godzinę w Excelu
SPOSÓB
39.

Sposoby na wbudowane mechanizmy Excela | 107

jest fakt, że gdy liczba godzin przekroczy 24 (czyli tak naprawdę osiągnie wartość 1), zosta-
nie to potraktowane jako początek nowego dnia i odliczanie godzin rozpocznie się na nowo.
Aby zmusić Excela, by po osiągnięciu 24 godzin nie rozpoczynał nowego dnia, można
w komórce użyć formatu w postaci 37:30:55 lub zastosować własny format [g]:mm:ss.

Podobnego formatu można użyć do obliczenia całkowitej liczby minut lub sekund, odpo-
wiadającej danej godzinie. Aby na przykład obliczyć całkowitą liczbę minut, odpowiadającą
godzinie 24:00, należy zastosować w komórce format [m] — wynikiem będzie wówczas
liczba 1440. Aby odczytać całkowitą liczbę sekund, należy użyć formatu [s], co w wyniku
da liczbę równą 86400.

Obliczenia na datach i godzinach
Jeżeli w innych obliczeniach trzeba będzie zastosować rzeczywiste wartości godzinowe,
należy zapamiętać poniższe kluczowe wartości, które zestawione zostały w tabeli 2.6:

Tabela 2.6. Kluczowe wartości przy obliczeniach używających czasu i daty

Liczba Opis

60 60 minut lub 60 sekund

3600 60 sekund*60 minut

24 24 godziny

1440 60 minut*24 godziny

86400 24 godziny*60 minut*60 sekund

Znajomość tych magicznych liczb oraz zachowanie w pamięci przedstawionych wyżej
informacji zdecydowanie ułatwi manipulowanie godzinami i datami. Aby się o tym prze-
konać, przyjrzyjmy się poniższym przykładom (założyliśmy w nich, że godzina znajduje
się w komórce A1).

Jeśli liczba 5,5 powinna być wyświetlona jako 5:30 lub 5:30 a.m., należy wpisać formułę:

=A1/24

i zastosować odpowiednie formatowanie.

Jeśli liczba ta powinna być wyświetlona jako 17:30 lub 5:30 p.m., trzeba użyć formuły:

=(A1/24)+0,5

Gdy trzeba przeprowadzić operację odwrotną, to znaczy godzinę rzeczywistą zamienić
na godzinę dziesiętną, należy wpisać:

=A1*24

Jeśli w komórce zapisano prawdziwą datę i prawdziwą godzinę (na przykład w postaci
22-maja-07 15:36), a potrzebna jest tylko data, trzeba użyć formuły:

=LICZBA.CAŁK(A1)
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Aby otrzymać wyłącznie godzinę, należy wpisać:

=A1-LICZBA.CAŁK(A1)

albo:

=MOD(A1;1)

i zastosować odpowiedni format.

Aby obliczyć różnicę między dwiema datami, należy wpisać:

=DATA.RÓŻNICA(A1;A2;"d")

przy czym w komórce A1 powinna znajdować się data wcześniejsza.

Funkcja ta zwróci liczbę dni pomiędzy dwiema datami. Jako parametry wskazujące rodzaj
wartości, jaki funkcja ma zwrócić, można również podać "m" (czyli miesiące, ang. Months)
oraz "y" (lata, ang. Years). Należy zaznaczyć, że DATA.RÓŻNICA (a w angielskiej wersji
Excela DATEDIF) jest w Excelu 97 nieudokumentowana i tak naprawdę jest funkcją po-
chodzącą z Lotusa 1-2-3.

Jeśli trudno jest powiedzieć z wyprzedzeniem, która data lub godzina będzie wcześniejsza,
pomocne okażą się funkcje MIN i MAX. Aby uzyskać gwarancję otrzymania prawidłowych
wyników, można na przykład użyć następującej formuły:

=DATA.RÓŻNICA(MIN(A1;A2);MAX(A1;A2);"d")

Ponadto w trakcie pracy z godzinami może zaistnieć potrzeba zidentyfikowania godziny
początkowej i końcowej. Jeśli na przykład w komórce A1 znajduje się godzina 20:50,
a w komórce A2 zapisano godzinę 9:50, to jako wynik odejmowania godziny począt-
kowej od końcowej (=A2-A1) Excel wyświetli wartość ######. Przyczyną tego jest fakt,
że Excel domyślnie nie potrafi obsługiwać godzin o wartościach ujemnych. O tym, jak
sobie radzić z godzinami ujemnymi, informuje punkt „Wyświetlanie ujemnych wartości
godzinowych” [Sposób 87.].

Niedogodność tę można również wyeliminować na dwa alternatywne sposoby, gwaran-
tujące otrzymanie prawidłowych wyników:

=MAX(A1;A2)-MIN(A1;A2)

Albo (w tym przypadku może zajść potrzeba sformatowania komórki jako tej, która wy-
świetla czas, jeżeli domyślnie będzie ustawiona na typ liczbowy):

=A1-A2+JEŻELI(A1>A2;1)

Można również dodawać w Excelu dowolne liczby dni, miesięcy lub lat do dowolnej daty:

=DATA(ROK(A1)+wartość1;MIESIĄC(A1)+wartość2;DZIEŃ(A1)+wartość3)

Aby do daty z komórki A1 dodać jeden miesiąc, należy napisać:

=DATA(ROK(A1);MIESIĄC(A1)+1;DZIEŃ(A1))



Sposoby na datę i godzinę w Excelu
SPOSÓB
39.

Sposoby na wbudowane mechanizmy Excela | 109

Excel udostępnia również kilka dodatkowych funkcji, stanowiących część pakietu Analysis
ToolPak. Należy wybrać polecenie Przycisk Office→Opcje programu Excel→Dodatki, wybrać
Dodatki programu Excel i kliknąć Przejdź. Następnie należy zaznaczyć pole wyboru Analy-
sis ToolPak i kliknąć przycisk OK (w starszych wersjach w menu Narzędzia należy wybrać
opcję Dodatki…, zaznaczyć pole wyboru Analysis ToolPak i kliknąć przycisk OK, jeśli wyświe-
tlone zostanie pytanie o zainstalowanie pakietu).

Wszystkie te funkcje można znaleźć na karcie Formuły w grupie Biblioteka funkcji po kliknię-
ciu przycisku Data i godzina (w poprzednich wersjach w Kreatorze funkcji, w oknie dialogo-
wym Wstawianie funkcji w kategorii funkcji Daty i czasu). Ich użycie jest bardzo proste
— najtrudniejszą częścią jest zorientowanie się, że są one dostępne, oraz ich zainstalowanie.

Domyślnie w Excelu 2007 dodatek ten nie jest zainstalowany. Aby go zainstalować,
należy kliknąć Przycisk Office→Opcje programu Excel→Dodatki, wybrać Dodatki
programu Excel i kliknąć Przejdź. Następnie należy zaznaczyć pole wyboru
Analysis ToolPak i kliknąć przycisk OK.

Rzeczywiste daty i godziny
Czasami w arkuszach zawierających zaimportowane dane (lub dane wpisane nieprawi-
dłowo) znaleźć można daty i godziny traktowane przez Excela jako tekst, a nie rzeczywiste
liczby. Przypadki takie można łatwo zidentyfikować, zwiększając nieco szerokość kolumny,
zaznaczając ją, klikając prawym przyciskiem myszy i wybierając polecenie Formatuj
komórki…→Wyrównanie i jako wyrównanie tekstu Poziomo wskazując Ogólne (czyli domyślny
format komórki). Po kliknięciu przycisku OK należy sprawdzić ułożenie dat i godzin. Jeśli
nie będą one wyrównane do prawej strony, będzie to znak, że Excel nie rozpoznaje ich jako
rzeczywistych dat.

Aby naprawić ten błąd, należy najpierw skopiować pustą komórkę, zaznaczyć kolumnę
i ustawić w niej dowolny format z kategorii Data lub Czas. Nie usuwając jeszcze zazna-
czenia, trzeba kliknąć prawym przyciskiem myszy, a następnie wybrać polecenie Wklej
specjalnie…→Wartości→Dodaj. Zmusi to Excela do przekształcenia wszystkich dat i godzin
traktowanych jako tekst na rzeczywiste daty i godziny. Być może zajdzie konieczność
ponownego sformatowania komórek. Kolejny, prosty sposób polega na odwołaniu się
do komórki (komórek) w następujący sposób:

=A1+0 albo =A1*1

Błędna data?
Excel błędnie przyjmuje, że rok 1900 był rokiem przestępnym. Oznacza to, że według
wewnętrznego systemu dat Excela istniał dzień 29 lutego 1900, choć w rzeczywistości go
nie było! Najciekawsze jest jednak to, że programiści firmy Microsoft uczynili to celowo,
a przynajmniej tak twierdzą! Więcej informacji na ten temat można znaleźć na stronie
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q181370.
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Poniżej znajduje się jeszcze kilka dodatkowych adresów do stron zawierających informacje
o datach i godzinach:

HOW TO: Use Dates and Times in Excel 2000

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q214094#6

Text or Number Converted to Unintended Number Format

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q214233

Maximum Times in Microsoft Excel

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q214386

Dates and Times Displayed as Serial Numbers When Viewing Formulas

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q241072

Controlling and Understanding Settings in the Format Cells Dialog Box

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q264372

How to Use Dates and Times in Microsoft Excel

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q214094

Daty i godziny sprawiają chyba w Excelu najwięcej zamieszania. Mamy nadzieję, że dzięki
przedstawionym informacjom łatwiej będzie zrozumieć ich tajniki, a praca z nimi będzie
zajmować mniej czasu.

S P O S Ó B

40.
Wszystkie

Używanie mechanizmów grupowania i konspektu
w zabezpieczonych skoroszytach
W Excelu 2000 firma Microsoft wprowadziła wiele różnych poziomów zabezpieczeń. Niestety zaniedbała
dodanie takiego, który umożliwia użytkownikom używanie mechanizmów grupowania oraz konspektów.

Aby umożliwić grupowanie i tworzenie konspektów w zabezpieczonym arkuszu, należy
najpierw ustawić grupowanie oraz konspekty. W tym celu należy zaznaczyć nasze dane,
wybrać polecenie Dane→Konspekt→Grupuj i z menu rozwijanego wybrać polecenie Auto-
konspekt. W ten sposób uzyska się dane wyświetlone w sposób pokazany na rysunku 2.29.

Następnie trzeba zabezpieczyć arkusz, używając do tego hasła Tajne.

Aby umożliwić wykorzystanie mechanizmu grupowania lub konspektu na zabezpieczonym
arkuszu, kod użyty w tym sposobie stosuje argument UserInterfaceOnly w metodzie
Protection (http://www.ozgrid.com/VBA/excel-macro-protected-sheet.htm), który normalnie
wykorzystywany jest do zabezpieczenia ogólnego interfejsu Excela, ale umożliwia zmiany
z poziomu makr. Zamknięcie skoroszytu spowoduje ustawienie UserInterfaceOnly
ponownie na False. Dlatego też należy skorzystać ze zdarzenia Workbook open, aby
ustawić ten argument na True.
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Rysunek 2.29. Dane z zastosowanym konspektem

Wadą używania zdarzenia Workbok Open jest to, że ustawienia zabezpieczeń na kom-
puterze mogą nie pozwolić na uruchomienie kodu przy otwarciu pliku. Aby mieć pewność,
że będzie to możliwe, należy ustawić poziom bezpieczeństwa na opcję Włącz wszystkie
makra (w starszych wersjach należy ustawić niski poziom zabezpieczeń).

Bardzo ważne jest, aby mieć świadomość, że ustawienie poziomu bezpieczeństwa
na Włącz wszystkie makra (Niski w poprzednich wersjach) powoduje, że komputer
jest podatny na potencjalnie niebezpieczny kod.

Aby użyć makra, należy kliknąć prawym przyciskiem myszy na zakładce arkusza, wybrać
polecenie Wyświetl kod, dwukrotnie kliknąć pozycję This Workbook (w poprzednich
wersjach należy kliknąć ikonę Excela znajdującą się w lewym górnym rogu, następnie
Plik oraz polecenie Wyświetl kod. Na koniec trzeba wkleić następujący kod:

Private Sub Workbook_Open( )
  With Sheet1
    .Protect Password:="Tajne", UserInterfaceOnly:=True
    .EnableOutlining = True
  End With
End Sub

Kolejnym krokiem jest zapisanie skoroszytu, zamknięcie go i ponowne otworzenie. Mimo
że arkusz jest zabezpieczony, a polecenie Grupuj nieaktywne (rysunek 2.30), użytkownik
powinien mieć możliwość korzystania z tej opcji w normalny sposób, gdyż została ona
już użyta do danych.

Rysunek 2.30. Zabezpieczony arkusz z wyłączonym poleceniem Grupuj
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W tym sposobie użyliśmy nazwy arkusza do tego, aby odwołać się do właściwego arkusza,
ale można w tym celu wykorzystać nazwę zakładki lub numer indeksu tego arkusza.
Jednak skorzystanie z nazwy arkusza jest najbardziej efektywnym sposobem. Należy
również zauważyć, że wykorzystane zostało hasło Tajne.

S P O S Ó B

41.
Wszystkie

Zabezpieczanie przed pojawianiem się
w tabeli pustych lub brakujących pól
Możliwe jest łatwe manipulowanie poleceniem Poprawność danych po to, by upewnić się, że na liście nie
znajdują się żadne puste pola.

Dzięki wykorzystaniu polecenia Poprawność danych możemy zagwarantować, że nasza lista
pozbawiona będzie pustych lub brakujących wpisów. W przykładzie wykorzystamy prostą,
dwukolumnową tabelę. Załóżmy, że nagłówkiem pierwszej kolumny będzie Imię, a drugiej
Departament (odpowiednio komórki A1 oraz B1). Chcemy, aby użytkownicy wypełniali
pola pod oboma nagłówkami, bez pozostawiania pustych miejsc. (Jeżeli ktoś rozpoczyna
pracę z tabelą, która posiada puste komórki do wypełnienia, powinien zapoznać się z ramką
Wypełnianie wszystkich pustych komórek).

Wypełnianie wszystkich pustych komórek

Jak zapewne większość z użytkowników wie, przeważająca część narzędzi Excela
— tabele przestawne, sortowanie, filtrowanie itp. — napotyka na problemy, kiedy
natrafi na puste pola w zakresie komórek, na których pracuje. Stąd poniżej znajduje
się szybki sposób na wypełnienie każdej pustej komórki wartością z komórki
nadrzędnej.

Powiedzmy, że pracujemy na liście wpisów w kolumnie A z wieloma pustymi
komórkami. Należy zaznaczyć kolumnę A, nacisnąć klawisz F5 (na niektórych
laptopach, takich jak modele MacBook, będzie trzeba trzymać naciśnięty klawisz
Fn przy naciskaniu klawisza F5), kliknąć przycisk Specjalnie…, zaznaczyć opcję Puste
i kliknąć przycisk OK. Wszystkie puste pola powinny być w tym momencie zazna-
czone. Teraz należy nacisnąć klawisz równości (=), po czym strzałkę w górę, a na
koniec, trzymając wciśnięty klawisz Ctrl, nacisnąć Enter.

Teraz należy zaznaczyć komórki A3:B100 i upewnić się, że zaznaczenie zaczyna się od
komórki A3. Następnie należy wybrać polecenie Dane→Narzędzia danych→Poprawność
danych (w starszych wersjach jest to polecenie Dane→Sprawdzanie poprawności), po czym
z listy rozwijanej Dozwolone wybrać opcję Niestandardowe i w polu Formuła wpisać nastę-
pujące wyrażenie:

=ORAZ(LICZ.JEŻELI($A$2:$A2)=WIERSZ()-2;LICZ.JEŻELI($B$2:$B2)=WIERSZ()-2)

Niezmiernie ważne jest, aby przestrzegać odwołań bezwzględnych $A$2
oraz $B$2 oraz względnych odwołań do wierszy i kolumn $A2 oraz $B2.
W przeciwnym wypadku uzyska się niewłaściwe wyniki.
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Następnie należy zaznaczyć zakładkę Alert o błędzie i wpisać odpowiedni komunikat błędu,
który wyświetlony zostanie użytkownikom, jeżeli pozostawią w tabeli puste pole (rysu-
nek 2.31). Należy upewnić się, że styl błędu ustawiony jest na Zatrzymaj, po czym kliknąć
przycisk OK.

Rysunek 2.31. Wyświetlanie zakładki Alert o błędzie

Zastosowanie sprawdzania poprawności zagwarantuje, że wszystkie wpisy (w tabeli
o rozmiarach A2:B100) będą posiadać zarówno nazwę, jak i departament dzięki temu,
że zablokowana została możliwość pojawiania się pustych komórek pomiędzy wpisanymi
i wypisywanymi komórkami.
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42.
Wszystkie

Tworzenie zmniejszającej się listy sprawdzania
poprawności danych
Czy nie byłoby korzystne, gdyby można było stworzyć użytkownikom listę opcji do wybrania, która malałaby
po wybraniu kolejnych opcji? Można stworzyć taką użyteczną cechę przy wykorzystaniu mechanizmu
sprawdzania poprawności danych i niewielkiej ilości kodu VBA.

Powiedzmy, że mamy jeden arkusz, na którym wielu użytkowników wprowadza dane.
Każdy z nich musi wybrać z listy sprawdzania danych pewien element. Po wybraniu przez
użytkownika takiego elementu dobrze by było, aby lista pokazywała jedynie pozostałe
pozycje (czyli te, które nie zostały jeszcze wybrane). Mechanizm ten może ułatwić i przy-
spieszyć wprowadzanie danych przez wielu użytkowników, a także zapobiec powstawaniu
zduplikowanych wpisów.
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Na dowolnym arkuszu należy dodać naszą listę — powiedzmy zawartą w przedziale
A1:A10. Następnie trzeba zaznaczyć ów zakres i kliknąć w polu Nazwa (na lewo od pola
formuły), wpisać nazwę MojaLista i nacisnąć Enter. Dzięki temu uzyskamy zakres nazwany
o nazwie MojaLista.

Następnie należy zaznaczyć zakres na innym skoroszycie, w którym chcemy przecho-
wywać listę sprawdzania poprawności danych, kliknąć prawym przyciskiem myszy na
nazwie zakładki i wybrać polecenie Wyświetl kod, po czym wpisać poniższy kod:

Private Sub Worksheet_Change(ByVal Target As Range)
  Dim strVal As String
  Dim strEntry As String
    On Error Resume Next
    strVal = Target.Validation.Formula1
      If Not strVal = vbNullString Then
        strEntry = Target
         Application.EnableEvents = False
        With Sheet1.Range("MojaLista")
          .Replace What:=strEntry, _
             Replacement:="", LookAt:=xlWhole, _
             SearchOrder:=xlByRows, MatchCase:=False
          .Sort Key1:=.Range("A1"), Order1:=xlAscending, _
             Header:=xlNo, OrderCustom:=1, MatchCase:=False, _
             Orientation:=xlTopToBottom
          .Range("A1", .Range("A65536").End(xlUp)).Name = "MojaLista"
        End With
      End If
    Application.EnableEvents = True
  On Error GoTo 0
End Sub

Następnie należy wrócić do Excela, zamykając wcześniej używane okno, wybrać polecenie
Dane→Narzędzia danych→Poprawność danych (wcześniej Dane→Sprawdzanie poprawności)
i z listy Dozwolone wybrać pozycję Lista, po czym w polu Źródło wpisać =MojaLista i kliknąć
przycisk OK.

Od tego momentu po wybraniu na liście imienia nie będzie się ono więcej na niej poja-
wiało.

Warto zwrócić uwagę, że użyliśmy odwołania do listy MojaLista w postaci Sheet1.
Range("MojaLista"), wiążąc zakres nazwany z kodem arkusza. Uczyniliśmy tak,

gdyż odwołanie do zakresu nazwanego (MojaLista) znajduje się już w module prywat-
nym innego arkusza. Bez tej konstrukcji Excel przyjąłby, że argument MojaLista znajduje
się na tym samym arkuszu, na którym umieszczony został kod Worksheeet_Change.
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43.
Wszystkie

Dodawanie listy użytkownika do uchwytu wypełnienia
Po wprowadzeniu kilku z własnych list użytkownika ciężko jest zapamiętać pierwszy element na liście,
który musi być wprowadzony do komórki. Niniejszy sposób dodaje listę do uchwytu wypełnienia.

Tworzenie w Excelu własnych list użytkownika za pomocą uchwytu wypełnienia jest
doskonałym sposobem na szybkie wprowadzenie listy numerów lub tekstu do arkusza.
Excel posiada wbudowane listy użytkownika dla dni tygodnia (od poniedziałku do piątku),



Dodawanie listy użytkownika do uchwytu wypełnienia
SPOSÓB
43.

Sposoby na wbudowane mechanizmy Excela | 115

miesięcy (od stycznia do grudnia) oraz sekwencji numerycznych, ale istnieje możliwość
zdefiniowania własnych list. Ten sposób pozwala na dodanie własnych list do uchwytu
wypełnienia, aby podpowiadać, jaki element musi być najpierw wprowadzony w komórce.

Należy zacząć od utworzenia własnej listy, wprowadzając ją na arkuszu. Załóżmy, że
posiadamy 10 nazw w komórkach A1:A10 na arkuszu 1. Jeżeli zachodzi taka konieczność,
należy posortować listę. Następnie trzeba wybrać polecenie Przycisk Office→Opcje programu
Excel→Popularne→Edytuj listy niestandardowe… (w poprzednich wersjach należy skorzystać
z polecenia Narzędzia→Opcje→Listy niestandardowe…; na komputerach Macintosh Excel→
Preferences→Custom Lists). Następnie należy kliknąć narzędzie do zaznaczania znajdujące
się z lewej strony przycisku Importuj. Korzystając ze wskaźnika myszy, trzeba kliknąć
lewym przyciskiem myszy na komórce A1 i przeciągnąć wskaźnik do komórki A10, po
czym kliknąć odpowiednio przyciski Importuj oraz OK. Od tego momentu zaznaczona
lista użytkownika będzie dostępna we wszystkich skoroszytach otwieranych na danym
komputerze.

Aby dodać listę do uchwytu wypełnienia, należy kliknąć prawym przyciskiem myszy na
nazwie arkusza i wybrać polecenie Wyświetl kod, po czym kliknąć Insert→Module i wkleić
następujący kod:

Sub AddFirstList( )
Dim strList As String
  strList = Application.CommandBars.ActionControl.Caption
  If Not strList Like "*...*" Then Exit Sub
  ActiveCell = Left(strList, InStr(1, strList, ".", vbTextCompare) - 1)
End Sub

Teraz trzeba dodać poniższy kod do modułu prywatnego obiektu arkusza (ThisWorkbook):

Private Sub Workbook_SheetBeforeRightClick _
  (ByVal Sh As Object, ByVal Target As Range, Cancel As Boolean)
Dim cBut As CommandBarButton
Dim lListCount As Long
Dim lCount As Long
Dim strList As String
Dim MyList
  On Error Resume Next
    With Application

      lListCount = .CustomListCount
        For lCount = 1 To lListCount
          MyList = .GetCustomListContents(lCount)
          strList = .CommandBars("Cell").Controls(MyList(1) & _
              "..." & MyList(UBound(MyList))).Caption
            .CommandBars("Cell").Controls(strList).Delete
            Set cBut = .CommandBars("Cell").Controls.Add(Temporary:=True)
              With cBut
                .Caption = MyList(1) & "..." & MyList(UBound(MyList))
                .Style = msoButtonCaption
                .OnAction = "AddFirstList"
              End With
        Next lCount
    End With
  On Error GoTo 0
End Sub
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Aby szybko się tam dostać z okna Excela, należy wybrać polecenie Developer →Kod→Visual
Basic, a następnie dwukrotnie kliknąć myszą pozycję ThisWorkbook (w starszych wersjach
należy kliknąć prawym przyciskiem myszy na ikonie Excela umieszczonej w lewym
górnym rogu obok menu Plik, a następnie wybrać polecenie Wyświetl kod). To miejsce,
w którym należy umieścić kod.

Od tego momentu za każdym razem, kiedy użytkownik kliknie prawym przyciskiem
myszy na komórce, zobaczy elementy pierwszy… ostatni z każdej listy użytkownika.
Pokazuje to rysunek 2.32.

Rysunek 2.32. Menu wyświetlane po naciśnięciu prawego przycisku myszy pokazujące listę użytkownika

Po wybraniu jednej z dostępnych list użytkownika jej pierwszy element umieszczany jest
w bieżącej komórce. Później wystarczy przeciągnąć kursor w dół, używając uchwytu wypeł-
nienia, aby uzyskać resztę listy.




